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Editor’s letter
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Magine

Overthinking projects can
destroy creativity, so it's
refreshing to discover this
issue’s cover artist embraces
the accidents that can happen
when creating art. Ayran

. . Influenced by Alphonse Mucha and a desire for greater
Oberto loves to paint with diversity in fantasy art, Lauren Brown is an inspiration.
spontaneity and on page 54

you can follow his process to

discover how you can harness your impulses.

There’s more control in Jean-Sébastien Rossbach’s
watercolour masterclass. The award-winning
illustrator reveals how he directs his paint and
explains how a dash of kitchen salt can make all
the difference.

The joy of editing ImagineFX is we can present
these two extremes, and everything in between.
Whether it’s using the latest digital tools and

You have the power... to make epic art!

techniques or developing your core traditional Ken Coleman uses 3D scanned action figures and
skills, we have you covered every issue. Corel Painter to create his vintage-looking poster art.
Never forget that this is your magazine, too. We

love supporting new artists in FXPosé - our global Ee
showcase of amazing new art. If you want to

feature in a future issue visit ifxm.ag/getinifx and
submit your portfolio.

Editor

ian.dean @futurenet.com Creature comforts with Glen Southern

Make use of ZBrush to speed-sculpt a life-like dinosaur,
and the artist shares his 50 texture brushes!

! finagiiierX
@imaginefxmagazine . ez SUbscribe
¥ @imaginefx ’ T F ‘< today!

f facebook.com/imaginefx S Sl e o el e
) and receive a copy of

B imaginefx.creativeblog.com | y S traditional media art

. . software Rebelle 4!
™ ifxm.ag/ifxnewsletter-v2 See page 8 for details.

Lgn v Tor o nenslecter!
: IR




Subscribe to ImagineFX and save up to 59 per cent, plus [T
receive the latest version of Rebelle! See page 8 for details /
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Workshops

54 Create spontaneous art
Ayran Oberto paints a colourful portrait
without overthinking anything.

60 From concept to 3D portrait
Anna Cavasos balances beauty and horror.

[ 62  Create retro art from 3D scans
s Ken Coleman demonstrates how he mixes
- scanned figures and digital painting.

3D 'bortrait

66  Apply a mix of CG skills to a
fantasy scene

Combine painting and modelling tools
with photobashing, with Oliver Beck.

70  Sculpt a real dinosaur
Creature artist Glen Southern breaks
down his ZBrush sculpting workflow.

Traditional Artist

84 Traditional FXPosé
Discover this month’s selection of the
finest traditional art, sent in by you!

88 Workshop: 11 tips on
rendering perfect portaits
Veteran artist Jean-Sébastien Rossbach
reveals how he works with watercolour.

94 Workshop: Fish-eye art skills
Learn how Paul Heaston creates a wide-
angle sketch in pencil, pen and ink wash.

( : 98 First Impressions:

tuls ] : : Wylie Beckert
Usa-il d§ 'j_‘ 5 SEL pHhEe This MTG artist thanks social media.




Resources

Résources

Getting hold of this issue’s resources is easy. g

Just visit ifxm.ag/paint204techniques 4 ,9,(\)/555
u£ grigeo tutorials

WORKSHOP VIDEOS
— o,

Be spontaneous in your art Take the wide-angle view
Watch Ayran Oberto develop a portrait in See how Paul Heaston is able to capture a fish-
Photoshop. His workshop's on page 54. eye view of his setting. More on page 94.

By the power of Grayskul Bring a dinosaur to life
See how Ken Coleman creates retro He-Man ~ Watch Glen Southern as he sculpts a dinosaur
art using 3D scans and Painter, on page 62. using ZBrush. His workshop's over on page 70.

Skeletor workshop assets 50 ZBrush Alphas
Use Ken Colman’s 3D renders and textures These Alphas from Glen Southern will help
alongside his retro art workshop on page 62.  you add realistic texture to your dinosaur art.

PLUS 44 CUSTOM BRUSHES, INCLUDIN
N T S

INK COLORVARIATION KEN THICK PAINT OlLY 2
Ayran Oberto uses this brush Ken Coleman applies paint effects Another of Ayran’s custom brushes,
to sketch out his ideas. with this custom brush. which he uses to paint hair.
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Next month in...

ImaginieX

Our artist super-team
unites to bring your
heroes to life!

Draw and paint
personality in
your character

art with Marvel

and DC Comic's

Joshua Swaby /

Terry Dodson
masterclass
Discover the pro
secrets to compose
and draw perfect
comic covers.

& l
f i B
/ Y

l

Reinvent a
classic hero
Marvel’s David
Nakayama reveals
how to redesign

an iconic character.

Craft intricate
comic panels
Master the classic
‘ligne claire’
comic-art style
with Igor Wolski.

Judge Dredd
celebration
2000 AD's leading
artists reveal why
the world of Dredd

remains vital.

ISSUE 205 ON SALE 3 SEPTEMBER IN PRINT & DIGITAL
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USE TRADITIONAL MEDIA IN YOUR ART WITH REBELLE 4

Watercolours, oils, acrylics and more wet and dry media are at your fingertips in the latest
version of Rebelle, enabling you to explore all kinds of realistic painting techniques!
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THE PLACE TO SHARE YOUR DIGITAL ART
-

Ahmed Rawi

Photoshop, Procreate, Maya, ZBrush, Keyshot
artstation.com/rawi

Ahmed is a concept artist and illustrator
who'’s worked for the video games and film
industries for over a decade. Nature and
music are his main inspirations.

WARRIOR THE CHASE

“A personal study | did during a new “Part of my series The Gleed Ghost. A
brushes/palette exploration session. It colourful flying spirit is chased by characters
ended up with an undead warrior design.” to find the secret behind its beauty.”

RUMI

“Jalal ad-din Rumi in a sci-fi setting. | was
keen to try Procreate’s glitch FX feature, so |
thought of a way to use it in a painterly style.”




Want to submit your work? Visit ifxm.ag/getinifx




X Posé

Ben Bauchau

LOCATION: Belgium MEDIA: Black ink (brush pen and Micron pens), Ph h WEB: b com

Ben’s main inspiration is ukiyo-e art, engravings and comics. His work,
which often involves surreal worlds, is also influenced by past cultures,
war, nature, movement and even the unconscious mind.

BLESSING OF THE OWLS CAGLAN THE GREY

“Exploring the idea of an imaginary afterlife “Part of a series of warriors called Clans of
ritual that occurred to me after hearing the Kimmeria. An exploration of feudal society and
mesmerising screams of an owl at night.” the culture of war.”

GORGE OF THE LIMBS

“This illustration takes the point of
view of a creature in the midst of battle,
keeping its defined form hidden to the
viewer. | was inspired by cosmic horror
and pulp literature.”

Want to submit your work? Visit ifxm.ag/getinifx




Davood Moghadami

Iran Photoshop davoodm.artstation.com

Davood had a childhood fascination for traditional painting,
but turned to digital art while studying graphic design. “I
particularly enjoy drawing and painting nature,” he reveals.

Want to submit your work? Visit ifxm.ag/getinifx

MOUNTAIN GLORY

“This is another piece
created with pens that |
made myself. The different
textures result in different,
more interesting work.”

Posé

OLD OAK

“In this piece | used
personal pens that | made
myself. This helped to
distance myself from analog
painting techniques.”

TOXIC FOREST

“As well as acrylics and
oils, I've long been inspired
by watercolours. This piece
replicates the watercolour
technique in Photoshop.”

o




Posé

Gabriel Rubio

Brazil Photoshop, Procreate artstation.com/gabrielrubio

Gabriel has been working in the games industry for the past five years, with
clients such as IGG, NetEase Games and West Studio. He’s influenced by
comic books and illustrators such as JC Leyendecker.

RAYGUN

“It was nice to have the
freedom to play with a retro-
futuristic vibe.”

SALADIN

“It was super cool to play
with the contrast between
the grumpy sultan and the
flamboyant genie.”

THE RED DRAGON

“This piece helped me
to find my own way of
rendering shapes. It was a
challenge to bring unique
shapes to all the characters.”

THE DRUNKEN
MASTER
“I revisited the first piece of
art | rendered in Procreate.
| tried to create a good vibe
with vibrant colours.”

Want to submit your work? Visit ifxm.ag/getinifx
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Want to submit your work? Visit ifxm.ag/getinifx ImasiieE =




Posé
Edit Ballai

Maya, Unreal Engine,

h h i.com

Since her early childhood, Edit has loved to write and illustrate stories about
imaginary worlds. “Nowadays | only focus on visual storytelling for video
game and animation studios,” she says, “but | might continue writing later!”

UTOPIA

“| created this scene for
Kitbash3D’s Utopia contest. |
really loved doing this piece.”

SKYSTEAD

“This has a little bit of a
Star Wars touch, created
from Jonathan Berube’s
industrial photo pack with
some love and Maya.”

LEFT BEHIND

“In this personal piece
| was just playing with forms
and shapes. Obviously,
there’s a huge reference to
the film Prometheus which
| liked a lot.”

Want to submit your work? Visit ifxm.ag/getinifx




Posé
\  Marby Kwong

Photoshop, Blender, 3ds Max artstation.com/marby

Appearing in FXPosé is something of a dream come true for concept artist
and illustrator Marby. “I've been reading ImagineFX since | was a wee art

1

student over 10 years ago. It was what initially got me into concept art

MUSHROOM KNIGHT

“Here | pushed the
fantastical character design
angle. | exaggerated
elements to tell the narrative
that she’s also a miner.”

VALKYRIE

“A more sombre piece,
inspired by Viking
mythology. | love using teal
and green in my paintings.”

PALALUMA ISLAND

“I wanted to convey a
bustling fantasy town. The
unusual building shapes
help to communicate that
it's otherworldly.”

Want to submit your work? Visit ifxm.ag/getinifx ImasiiieEX W




ARTIST NEWS, SOFTWARE&EVENTS

AT THE CORE OF THE DIGITAL ART COMMUNITY

magmeNation

A celebratory scene
from US illustrator
James Gurney's
Dinotopia book series.
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Why books still
matter to artists

Page turners Book sales are on the rise and when it comes to art
training the printed page is still important, discovers Ian Dean

o

We live in the internet age where
training is just a click away. But
despite this we continually return to
books. Even when learning could be
gained online, educational book
sales brought in £6.4 billion in the UK
in 2020. Consumer book sales fared
even better, rising seven per cent to
£2.1 billion last year.

Clearly the printed word hasn’t lost
its appeal, and for artists in particular,




©Marvel/Disney

Kan Muftic reveals that studying
books on the technical aspects of
filmmaking helped take his art in a
new direction, and created new
career opportunities, too.

page. “Always,” states
concept artist and
director Kan Muftic
(ifxm.ag/kan-m) as we
ask if he still relies on art books for
advice. “A book is an object with a
physical and mental presence in my
life,” adds the artist, whose own book
Figure Drawing for Concept Artists
has proved popular.

Kan reveals that “The beautiful
books of Marcos Mateu-Mestre” got
him through lockdown. The love of a
physical art book was instilled in him
at an early age: his parents had a
collection of Sergio Toppi books that
inspired him growing up.

You can track a person’s life through

their book collection, and see the
influences in their work. Kan himself

many have returned to the |
¢ comic art of his childhood and now

. directs for TV: his animated short Kiss
' Me First is on Netflix. Reading film
theory has not only aided him in

| making the leap to film, but helped
his art, too. “Learning about camera
lenses in various filmmaking books

| completely changed the way | create
. images,” he tells us.

 BOOKED IN

Art books enable us to focus and

i challenge ourselves where perhaps
other mediums fail. During lockdown

' Kofi Ofosu (ifxm.ag/kofi-o) turned to

Artist news, software & events

has grown beyond the fantasy and

Figure Drawing and
Invention by Michael
Hampton. “I wanted to
get back to my anatomy
fundamentals and

Kofi Ofosu prefers books to online learning, saying
' it’s easier to access advice when it’s printed.

mprove my figure-drawing skills,” he

says. It was a moment that took the

llustrator full circle back to his artistic

: grounding. Kofi’s first book that he
. owned was Drawing Heads and

' Hands by Andrew Loomis, and his
. most recent acquisition is Force:

Dynamic Life Drawing.
He tells us: “There are so many

. greatart training books available that
i contain lots of gems of advice. | have
. gotten a lot of invaluable information

through reading art training books
- much of this information is difficult
to find online.”

For Kofi it's about being able to get

. as close to an artist’s work and

: thought processes as possible. The

. pitfall can come if you follow the

. advice too closely and fail to interpret
| and instead merely copy.

66 There are so many great art
training books available that
contain gems of advice 99

On this matter Kofi says: “This

' advice wasn’t necessarily a technical
i one, but it was a quote from Frank

Frazetta, which goes something like

this: ‘Don’t be a second-rate Frazetta,
. be afirst-rate you.’

“It greatly helped me because as a

| young artist | always wanted to

- become like other artists.

. I'had never thought about getting
* truly in touch with my own artistic
: voice. Reading these words from

Frazetta helped me to understand
that as a creative, we're most powerful
when we're fully 3>




ImagineNation News

James, while recommending
books by Andrew Loomis,
Harold Speed and,John
Carlson, also stresses the
importance of putting
theory into practice.

This is Kan's concept art of
Tabaqui, a jackal that
appeared in the film Mowgli
Legend of the Jungle.

B> expressing our unique artistic
vision rather than pretending to be
someone else.”

This is a balancing act that all artists
walk. Interestingly, one of the most

popular art book authors,
James Gurney
(jamesgurney.com), has

U managed to side-step the

problem altogether.

“l became an artist in a vacuum,”
James says with clarity. “No one else
in my family was an artist. | didn’t
have art friends until after college,
and there was no internet back then.
That absence of community and

connections made it a lonely quest,
but in retrospect it was the best thing
for me. It helped me develop
completely independently, and |
didn’t suffer through the nonsense
that art students around 1980 had
to endure.”

James reveals how he had to create

5018 IBUIEME

¢ Kofi recommends

| Dynamic Life Drawing
. by Michael D Mattesi:
i "It teaches how to

| create drawings that

i evoke emotion.”

his own artistic training programme to

learn how to paint and draw. His self-
diagnosed training focused on the
instructional books of Golden-Age
illustrators and academic painters,
such as The Famous Artists’ Course,
and the books by Andrew Loomis,

and Harold Speed and John F Carlson.

66 I knew I had to face the real world
with my sketchpad and just draw, draw,
draw from memory and imagination 99

“But | knew that you can’t become

. an experienced painter by reading

i about it, any more than you can learn

. to draw by binge-watching YouTube

| videos,” he cautions. “l knew | had to

- face the real world with my sketchpad
and just draw, draw, draw from
memory and imagination. | made
regular trips to the zoo and the natural
- history museum.

“When | got the job painting

animation backgrounds, | learned to

. paint a lot and paint fast. Working as
a National Geographic illustrator

! taught me the importance of research
| and accuracy.”

 ABALANCING ACT

For James, who has a number of

. must-read books to his name,

i including the Color and Light: A Guide
| for the Realist Painter, there’s still 3>




Artist news, software & events

Given the choice between
online art advice and a printed
tutorial, Adam Hughes will
likely plump for the latter.

INDUSTRY INSIGHT
WHICH BOOKS
DO OUR PROS
RECOMMEND?

This issue’s professional artists
pick the training books that they
can't do without...

Kofi Ofosu

Force: Dynamic Life

Drawing by Michael

D. Mattesi. The
reason I'd recommend this
book is because it teaches how
to create drawings that evoke
emotion - how to capture the
soul of your subject matter
rather than just copying down
what you see in front of you.
ifxm.ag/kofi-o

Kan Muftic
Cinematic
Storytelling by
Jennifer Van Sijll is
an absolute must for anyone
interested in creating art with
narrative depth. There’s an
endless supply of superficial
‘popcorn’ artwork created solely
with the purpose of gaining
followers on social media with
no substance whatsoever. This
should help.
ifxm.ag/kan-m

Adam Hughes
Figure Drawing For
All It's Worth, by
Andrew Loomis.
It's got everything you need
to go from the basics to full
illustration. And it’s got some
nifty techniques for drawing
figures in perspective.
instagram.com/atomhues

James Gurney
Recently I've been
: focusing on how
¥4 new findings in
neuroscience can help us better
understand the process of
painting. I've been revisiting the
classic book on that topic,
Vision and Art by Margaret
Livingstone, and I enjoyed the
recent book Seven and a Half
Lessons About the Brain by Lisa
Feldman Barrett.
jamesgurney.com




James learnt the value of:
arch and aceuracy”

vhile working on Natignal
Geographic magazine,

®» the need to balance relying on
training with the act of doing. His first
book, the Artist’s Guide to Sketching
(co-written with Thomas Kinkade)
grew out of this belief.

He explains: “We left art school for
a summer, riding the freight trains
from Los Angeles to New York City.
After sketching portraits of
lumbermen, gravestone cutters and
ex-cons, we had the crazy idea of
writing a book about sketching from
life - a topic that was rarely covered
by art training books. This was before
anyone talked about urban sketching
or plein-air painting. We didn’t go
back to art school because the
process of writing that book was
our education.”

So what’s left to learn? How about
writing your own book? James shares
some insights he’s gathered over the
years from his own writing process.
“The most important principles are

©Marvel/Disney

. Concept art of The
Ancient One from
Doctor Strange, as

¢ painted by Kan.

Knowing the difference
t o}

! brevity and clarity,” he says. “If you

- can say the same thing with half the

: words it’ll probably be more forceful.
If something is a fact, such as the

| inverse square law of light, state it

. authoritatively. If it's a debate, such

© as whether there’s such a thing as a

. muddy colour, present both sides of
the argument. If it’s a myth, such as

¢ the notion that our eyes move through

66 Cracking open a book is
like discovering the Secret
Knowledge of the Universe 99

| apictureina smooth spiral, blast the
i myth and offer the facts.”

Comic art legend Adam Hughes
(instagram.com/atomhues),
agrees, “Robert McKee, in one of his

screenwriting books,
pointed out the difference
between arule and a
principle,” explains Adam.
“Arule says, ‘You can’'t do
this’ while a principle says, ‘This has
worked since time immemorial and
will always work for you.” That positive
idea applies to illustration and it really
made me look at the rules in a
different way.”

During lockdown Adam found
himself not looking to an art training
book for inspiration but a novel:

JRR Tolkien’s The Lord of the Rings.

“| just keep rereading it, planning
future fun drawings,” he says, adding
jokingly: “All my other favourite stories
keep getting recontextualised -
looking at you, Star Wars - and | like
one thing to never really change by
telling me Frodo was a robot the
whole time.”

Yet Adam is a traditionalist when it
comes to the internet versus book
training. “The Internet is quick and
easy - ‘WebMD, do | have a brain
cloud?” - but cracking open a book is
like discovering the Secret Knowledge
of the Universe.” g




Artist news, software & events

THE SIX BOOKS EVERY ARTIST SHOULD READ

If these aren't on your studio’s bookshelves, put your order in at your local bookshop today!

HEAD & HANDS

RICHARD WILLIAMS

exPAN]

=Dimon

wANIMATOR'S
SURVIVAL KIT

Drawing the Head and Hands
Andrew Loomis’ explanations are detailed
and engaging, and it's hands-down the best
anatomy reference book despite its age. The
author's systematic approach will help you
understand the principles behind drawing
realistic portraits. Aside from the artistic
advice on offer, Drawing the Head and Hands
makes an excellent coffee table book, too.

How to Draw Comics the Marvel Way
If you're looking for a crash course in figure
drawing, or if you're an aspiring comic-book
artist, animator or illustrator, grab a copy of
Stan Lee’s How to Draw Comics the Marvel
Way. You'll also learn about composition, shot
selection, perspective, character dynamics and
more. If you're an artist and comic book fan,
then you need this book.

The Animator’s Survival Kit

Richard Williams’ book represents the 50-year
career in animation of an artist who won three
Oscars, three British Academy Awards and
over 250 other international awards. .. and he
created Roger and Jessica Rabbit. It's blend of
tips, tricks and insights for all forms of
animation will teach newcomers the ropes
and make old hands rethink their work.

DRAWNeLIFE

20 GOLDEN YEARS OF DISNEY MASTER CLASSES

Walt Stanchfield

Edited by Don Hahn

Drawn to Life: 20 Golden Years

of Disney Master Classes

Walt Stanchfield’s advice focuses more on the
emotions, life and action than proportions
and technical accuracy. With the emphasis on
gesture drawing, don't expect a book filled
with finished art; it's more about capturing
the moment. If you're interested in creating
drawings with character, this is a must-have.

A Guide for the
Realist Painter
James Gurrney

DINGTOPIA

Color and Light: A Guide
for the Realist Painter
James Gurney mixes art and science, theory
and practice, and delivers easy-to-understand
tuition. The impact of light and colour on a
painting is one of the hardest concepts to
grasp, but this book makes it accessible to all.
A perfect companion to James’ Imaginative
Realism: How to Paint What Doesn't Exist.

THE HEAD
& FIGURE

Drawing the Head and Figure

You could say that this publication is in direct
competition with Andrew Loomis’ books, and
you'd be correct. However, Jack's approach to
drawing the figure is more simplistic than
Loomis’. His step-by-step approach will have
even the most inexperienced artists drawing
better and more confidently. An excellent
primer for learning how to make marks.




Wake up
to online
conferences

LightBox Expo Online’s co-founder
Jim Demonakos reveals how to get more
from virtual events this summer

Imagining what this year’s LightBox
Expo Online (LBXO) will look like is
easy - it’s like last year’s, but bigger!
Founded by Jim Demonakos and
Bobby Chui, this online event aims to
bridge the gap between a physical
space and a virtual show.

Once again the event, which starts
on 7 September, will be split into
different areas: demo-based
programmes, an artist alley and social
hangouts. The LBXO approach feels
like a festival of talents.

The show’s Artist Alley is a live
virtual space - an interactive booth

v experience that you can
wander around. As
explains: “[Last year] we
‘ were able to let our

3 attendees discover the
artists in the same way they would
in-person, by ‘walking’ down the aisles
of the convention floor. The virtual
Artist Alley generated over one million
clicks alone.”

Magma Studio, one of the highlights
of last year’s show, is making a
welcome return. This software was
co-created by the LBXO team and

enables artists to collaborate on the
same canvas, in a browser window. “It
was a hit,” says Jim. “Being able to
draw with your friends in real time on
a shared canvas was a game changer.”

For 2021 the team is bringing this all
back with improvements. It's now a
six-day event, enabling more people
to explore the virtual Artist Alley
without competing against scheduled
sessions. New to LBXO are Activities:
challenges for people to take part of,
and the show will be on Discord.

EXPO TIPS

Does Jim have any advice for getting
the most out of LBXO? “Do your
research and plan,” he says. Last
year’s show ran for three days and had
400 programmes. You can expect this
number to double for 2021’s show.

He continues: “What’s your goal for
the event? Make sure you attend all

LIGHTBOX

Clear your diaries -
this year’s LightBox
Expo Online kicks off
on 7 September.

Jump into the chat on a
video you're watching and

find fellow peers

“hiu, who co-fou
Box Expo with Jir
>emonakos in 2019

i the lectures that are of interest to you.
. Use a calendar app to remind you of

- what you want to do, and make sure

| to manage your time so that you're

~ able to get food and take care of

. yourself while participating.”

Part of being a creator is being part

. of the creator community. “Make sure
| tojump into the chat if you can on a
video you're watching and find fellow
. peers,” advises Jim, who says parts of
© LBXO are relationship builders.

i “Online Portfolio Reviews are a great

i thing to participate in. Even if you're

: ‘not there yet,’ you'll have an
opportunity to make an impression on
. arecruiter, who might just jot your
name down for future reference.”




A keyframe that Luca Nemolato
painted for the popular real-time
strategy mobile game War Dragons.

[n partnership with @

A day in the life of...
Luca Nemolato

Healthy living Discover what colourful beverage sets
this Italian concept artist up for a hard day’s work

“l wake up at 8.30am and do some
stretching, then shower and get a
tea. | drink a lot of green tea because
I really got into fasting and
meditation - if | don’t get a tea, |
can’t really function. | start my
morning slowly by tidying up the
house and answering emails.

Around 9.30am, | get really into my
work and | don’t take a break until
around 4pm. If | stop for lunch then

Luca graduated in fine art in 2010, and continued to
sharpen his art skills at Gnomon School of VFX.

| get sleepy and I’'m not productive at
all. At 4pm | eat a quick protein snack
and meditate. Then | work out for an
hour and get ready to cook dinner.
I've been doing keto for a long time
and | really like cooking.

After | eat dinner and clean the
kitchen, it ends up being around
9.30pm. | usually go back to work
until 3am, then | go to sleep and do it
again the next day. The weekends are
for friends, gaming and cheat days.

As a freelancer, | usually have one
full-time client and then some side
part-time things that | can handle. My
main advice is to be communicative
and set boundaries with clients, so
you're able to meet your deadlines
and live a healthy life. When you don’t
underestimate deadlines, you're able
to deliver quality work every time.”
Los Angeles-based Luca’s projects include
The Shape of Water, Godzilla: King of the
Monsters and Jungle Cruise. He's currently
busy at Netflix, working on Gore Verbinski's
untitled animated film. You can see more of
Luca’s art at artstation.com/lucanemolato.

CONCEPT ART
ASSOCIATION

Concept art of ST.R.I.LPE, an
armoured robotic suit that
appears in the show Stargirl.

8sI8MUN DA &

CONCEPT ART
ASSOCIATION

Concept Art
Association is an
organisation
committed to
elevating and
raising the profile
of concept artists,
their art and their
involvement in the
entertainment
industries. Its
annual Concept
Art Awards Show
showcases and
recognises
behind-the-scenes
individuals
working in
entertainment
concept art.
conceptart
association.com.

Luca’s concept art for Blackstar, a supervillain from
the Netflix superhero show Jupiter’s Legacy.
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Isabelle Staub has been using
Corel Painter for seven years, ever
since she discovered the software
at college. Finding a digital art tool
that can replicate traditional
textures suited her art style.

Painting a successful
freelance career

Brush up Corel Painter has been used by professional artists for
30 years. Isabelle Staub reflects on how Painter has helped her...

going freelance. “[In] hindsight, | don’t | Createdasathrowback
. . ) to her Disney Princesses
think | would have ever felt ‘ready’ to | range that caught the
start freelancing. For me, it was i eve, this portrait was
. . . . inspired by the
something | just needed to jump in

: absent-minded Dory
and figure it out along the way

Today, Isabelle Staub
is a successful digital
artist who’s worked
with Marvel, Dynamite
Comics, Wacom and

: from Finding Nemo.

d
TikTok. Shooting to fame by
reinterpreting Disney’s Princesses in
her own unique style, Isabelle has
since gone on to create clothing
ranges as well as illustrations.
Reflecting on her first freelance gig
Isabelle says she was daunted and
excited by the job. “I was ecstatic
when | landed my first freelance job,
but | honestly felt like | had no idea
what | was doing,” says the artist. “At
the time, | was a few months out of
college and | still felt like a student
with little business knowledge at all. It
was definitely daunting, but |
pretended like | knew what | was
doing when speaking to the client.”
She admits to using Google and
pestered her college professors for
advice on pricing, invoices and how to
tackle the basic business aspects of

through trial and error,” she says.

BRUSHING UP

While Isabelle’s business knowledge

has grown over the years (social

media and new art trends have

changed how she works), some

aspects of her process have remained. :

The artist is committed to using Corel

Painter to achieve a traditional texture

in her portraits. |
She tells us: “I learned Painter during |

my freshman year of college in a

66 [ was very much a

traditional artist and Corel
enabled me to continue that

painterly style

. digital painting course. | was very

- much a traditional artist and Corel

: enabled me to continue that painterly
. style with its program. Being able to

. use brushes like oil paint, charcoal and
chalk made learning digital painting

i much easier and comfortable for me.”

That textural connection to

| traditional painting is why Isabelle

: has remained a Painter artist all these
| years. “For my work,” she explains,

“I still want that feel of paint and

. movement that you achieve with
 traditional mediums.”

Even after all this time Isabelle

| remains loyal to just five different
: brushes to create her work. We expect

Painter 2022’s new Favorites feature




This was created for the
Corel Painter Essentials 8
program. Isabelle says the
Essentials range is perfect
for creating art on a budget.

- that enables artists to select their
most used brushes - will be part of
Isabelle’s Painter workflow.

She particularly loves the Concept
Art Jitter Smooth brush and the
Glazing blender. “| use layer
commands a lot as well, especially Gel
or Colorize, to glaze or change colours
easily,” she adds.

TRY ITNOW

If you’ve not yet experienced Corel
Painter, Isabelle says there’s no better
time to try it out. She has some advice
for novices: “Play and experiment!
Don’t jump into doing a full-blown
piece. Take time to sketch with
different brushes, layer commands

and paper textures. Once you find
things that work for you, it’ll make
digital painting a lot less intimidating!”

When not experimenting digitally
Isabelle loves getting back to her roots
and throwing real paints around. The
two disciplines can work together.
“The other day | took a giant canvas
outside on a beautiful day and just
splashed paint all over it - it was
awesome! Art as a job can be
creatively draining, so it’s super
important to keep things fun and light
when you get the chance,” she says.
Download a free demo of Corel Painter
2022 at painterartist.com/future and try the
software for yourself. The new Painter 2022
is on sale now.

Advertorial

Corel Painter enables a
tradition: | to br
strol

Isabelle Staub has used
Painter all her career,
including to create
merchandise such as
these beautiful phone
cases for CASETIFY.

CASE STUDY

Isabelle Staub has used her Painter skills to create art
on almost anything, including mobile phone cases

Painting portraits and illustrative art is one thing, but
Isabelle has found herself adapting her skills to new
ranges and styles of work. Recently, she created a series of
designer phone cases for lifestyle brand CASETiFY. This
demanded Isabelle step outside of her comfort zone and
think differently about her art.

“Formatting my art to fit a phone case was surprisingly
challenging for me,” she tells us, explaining the art was
already created in Painter. “I had to tap into a design and
marketing-oriented thinking when creating my line with
CASETIFY. It was a different experience for me, but it has
been so rewarding to see my art in that way!”

Get inspired to go freelance and see more of Isabelle
Staub’s art, shop, and projects at isabellestaub.com.
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Erln This takes pride of place
on my wall and I'll often
stare mindlessly at him

H [ ] (his eyes move back and

unung forth along with his tail)
while | try and dream up
something for a project.

Cluttered fun This

Australian artist says she’s

used to being watched,

by real and unreal eyes. ..

1 live in a quiet suburb
in Melbourne,
Australia and on most
days you’ll find me in
here. The room
doubles as a lounge room, so there’s
a good chance Pll be curled up
watching TV, movies or reading -
even on my ‘off days’.

My collection of toys and figures are
everywhere: from glass cabinets, to
spilling over and overcrowding my
bookshelves. Along with hand-drawn
pieces from friends and colleagues
hung up around me, inspiration is
everywhere | look!

I've always loved collecting toys,
starting with Garfield and Care Bears
PVCs, and ALF plush dolls during =

Hellopgls

FROSTED
FI.AKES

Hey, it's Tony Tiger! One of my favourite things to
draw is iconic characters in my own style.

% ImasiierX

w | picked these up second

hand - I'm pretty sure you could
buy them with KFC meals in the
1990s. They make great pen
holders, although Wile’s big
snout often gets in the way.
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| have a strong love of mascot design and picked s"
this up via eBay. It’s a genuine advert from a

US newspaper on Frosted Flakes and | think the
artwork and design is perfection.

It seems I'm intent on £ A
appeasing my 10-year-old
self as | always wanted a
Garfield phone as a kid,
and | finally have one

These are by far and away

the best markers I've come

across, and | try and create a

_ traditional piece at least once
a week with them. It's a great
way to reconnect and

remind myself why | love
drawing in the first place.

I've used my Cintiq for about five years now. It's an
invaluable tool to my work and has helped me
create many books over hundreds of hours of work.
By far one of the best purchases I've made!

| picked up this guy
second hand, just
before Melbourne’s
latest lockdown. He's
one of the most striking
toys | own. | always
wanted one as a kid,
but never did get one
until now.
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»» my childhood, and somehow that
love has followed me all the way into
adulthood. As I've grown older I've
found myself getting overly nostalgic
about the vintage toys. So most days
- whether it’s in between jobs or after
a long day in front of the computer
working - you'll find me pouring over
eBay listings.

Before Covid, you'd see me often at
the local Melbourne toy fairs, but since
Australia is such a small and isolated

&6 I prefer to work in the
quiet of home rather than !
opt for a shared workspace 9

ought this big glass cabinet to
e some of my more delicate

id | love peering at it at
erent times of the day.

| markers, which | discovered around 15
i years ago. | find using traditional tools
. help keeps me excited and feeling

somewhat fresh about my artwork.
I've been freelancing for about 10

i years now and have worked with

island, we never have had an
bookshelves and | abundance of collectables. So a lot of
books, you'll findafew . my |atest items are from all over the
that I've illustrated, with | )

the most recent being | World = mainly the US - although my
Labyrinth: Straightto -

the Castle, published | most recent find has been an old

by Insight Editions. . Count Duckula moneybox from

© South Australia.

 CHANGING ART

. For client work | always work digitally
these days, almost exclusively on my
. Wacom Cintig. Around 10 or so years
ago | would pencil and ink my work by
! hand, scan and then colour my

. scanned line-work with a no-name

| tablet in Photoshop. The art world is

. quickly and ever-changing and
evolving, and sometimes it’s hard to

: catch up. For downtime sketching

| I still like to pencil and ink by hand,

. and will colour my work with Copic

Among the many

| companies like Sesame Workshop,

. Nickelodeon, Penguin Random House
. and Netflix, and still get a thrill when

| receive an exciting work opportunity.

Most of my communication is done

. via email so it’s quite a solitary

| existence, but | prefer to work in the
quiet of home rather than opt for a

. shared workspace, which I've found
distracting in the past.

I'm lucky to have my cat Louie to

| share my space with. He's great

| company, although he’s known to

. steal my office chair whenever | leave
| it for aloo or drink break!

- Erin is a character designer and illustrator
who has illustrated books for Penguin,

| Random House and Insight Editions, and
drawn comic covers for Jughead, Adventure
: Time and Rick and Morty. Discover her art
| and portfolio at erinhunting.com.




Here’s Louie (who is by far the most
photogenic out of the two of us)
biding his time to steal my seat.

I have so many Copics
(after collecting them for
over 15 years) and have
my favourite colours in
this plastic case, for
convenience - because
there’s nothing worse
than trying to find a
colour mid-drawing.

Yet another bookcase full of toys and
books. Those Grumpy Cat salt and pepper
shakers (right) were based on my designs
and hey, there’s my second Garfield phone!

vopAogRuGAS it
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| Here'’s Tony
r again, plus a he:

CLASS of 90
In 2019 | was commissioned by Will Smith and his

team to create art for his social media. This one
was 90s characters, including the Fresh Prince.

The one piece of work | have of mine
on display is the Adventure Time cover
that | drew for BOOM! Studios in 2016.
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Letters

YOUR FEEDBACK & OPINIONS

Contact the editor, Tan Dean, on
mail@imaginefx.com or write to
ImagineFX, Future Publishing,
Quay House, The Ambury,

@ Bath, BA1 1UA, England

Follow us on Twitter:
twitter.com/imaginefx

Find us on Facebook:
facebook.com/imaginefx

Share your artwork via #imaginefx:
instagram.com/imaginefxmagazine

New works that have
grabbed our attention

O7115800 2y Jo sprezip, &

- Crystal Sully make his break in FXPosé. We're always
keen to give new artists a platform.

' Kickstarted career

- Six or seven years ago my work was

Scrap ImagineFX?

A short while ago I purchased some
duplicate issues of ImagineFX and cut
them up to make a scrapbook of
inspiration for my concept art course
that I begin this September.

I've found this scrapbook to be
incredibly useful for inspiration,
especially since the magazines provide
so many pieces of art that I otherwise
wouldn't have ever discovered! I would
like to expand on my scrapbook, but
I don't want to cut up any of my current
magazines as they're such an amazing
read. So I was wondering if you had
any magazines anywhere that were
damaged, misprints or just old issues
and if it were possible for me to pay
shipping to receive them.

Thank you so much for making
such an amazing magazine. It's given
me so much to learn and has helped
me tremendously on my art journey.
Rebecca Wathen, via email

Ian replies It brings a tear to the eye, but
turning ImagineFX into your personal mood
boards sounds like a great idea for recycling
old, damaged or duplicate issues. I'll take a
look under art editor Dan’s desk. ..

T TR R

A |

DID YOU MISS
THE PREVIOUS

PACKED ISSUE? !

Don't worry -
you can get hold
of issue 203
atifxm.ag/
single-ifx.

Rebecca Wathen loves to
chop up her ImagineFX
to create scrapbooks (oh,
the horror!). Readers -
do you have spares?

featured as Artist of the Month in
ImagineFX back when my career was

| juststarting to take off for the first time.

Years later my work is now the face of

- Dungeons & Dragons with Wizards of

- the Coast, having just released my latest

-~ piece to announce its upcoming book

- Fizban's Treasury of Dragons. I've
published my own art book after an

- incredibly successful Kickstarter that

. funded at 1,000 per cent, called The

- Untamed Beastiary: A Field Guide to

- Marvelous Monsters.
I'would like to thank you for featuring
- me so long ago when I was just getting
- my career started.
. Crystal Sully, via email

~ Art exposure

~ I've been a subscriber of your wonderful

- magazine for the past few years. Since
my mailed copies run a little behind,

- I decided to take a sneak peak at the

~ digital copy of the September issue.
What an awesome and wonderful

- surprise to see my work featured in the
FXPosé section of artists! I want to say

- thank you very much for including a
sampling of my work!

~Its truly an honour to be recognised

- and induded among so many of the

 talented and innovative artists that are

- always featured within your pages.

In the meantime, though, I continue
 to create, and continue to enjoy and be
- inspired by your publication and the

ImagineFX community.
- Kait Matthews, via email

' Ian replies FXPosé is one of my favourite

- sections of the magazine. Every issue uncovers
- new artists who I know we'll see more of in the
* future, and it’s a pleasure to have them all be a
- part of ImagineFX. Keep submitting!

Eric Messinger

©) @ericmessingerart

Marcus Williams
@marcusthevisual

) Matias Bergara
@matibergara
If you've created art that you want us to

shout about simply tag us on Twitter or
Instagram, and use the hashtag #imaginefx

¥




IN ALATE COUNTRY: NEODYSTOPIA

“Created for Marc Trummer and his
band Mycelia’s concept album,” reveals
Logan Preshaw. “What looks like dark
sky is just more dense cityscape
hanging overhead.”



Logan Preshaw
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0GAN PRESHAW

lan Dean discovers a vis-dev artist and art director whose
approach to life is as bright as his paintings

any of what I
consider to be the
most successful
and influential
concept artists are
: unconventional and

highly stylistic,” says Logan Preshaw,
who acknowledges that defining a
new style in concept art is difficult.
“But when I think there couldn't
possibly be any more originality left to
be explored, a fresh new artist crops
up and blows that presumption away.
I think the key to that is working
towards a style that combines all of
your most treasured influences,
because the result of that probably
doesn't exist yet.”

In Logan’s work that often means
painting colour with abandon. It's a
refreshing approach for an artist with a

career that's seen him work at Weta
Workshop, Studio Moshi, Working
Dog and numerous studios in and
around his native Australia and
New Zealand. For an artist who's
CV lists video games Valorant and
League of Legend, as well as films
such as Men In Black: International,
and the forthcoming Avatar sequels,
that’s impressive.

His paintings, both personal and
professional, feature explosions of
colour. They're loose and active, and
rarely let the eye settle. He tells us it
was never a conscious choice to make

kk Computer screens can't
capture all the subtleties of
colours in real life... 1%

: colour a dominant part of his art.

| “While I was defining my approach to
. painting I played with colour in many
| ways until it began to look appealing

- tome... and I mean not just realistic,

. but appealing and pleasurable,” Logan
- explains. “I do that with many

. elements in my work, but I think the

- general audience notices colour first

- and they're less likely to pay attention
. to other fundamentals like perspective,
- contrast and form language.”

He goes on, telling us colour in his

. art is “hedonistically motivated” and

. tuned to bring pleasure. “It goes

| beyond simply using it as a utility to

. describe a scene, and more into the

. realm of exaggeration and idealisation
- to make it ‘juicy’ and almost tactile.

. Computer screens can't capture all the
| subtleties of colours in real life, so =+




Interview

» I think that's almost necessary to
fill the gaps.”

There’s a sense of joy to Logan’s work
- avitality that keeps you looking. He
says experimentation was the most
important aspect of his art education.
It's a motivation he continues to work
with, and believes once you've learned
the rules of art and have understood
the theories behind good paintings,
you need to break them.

“You need to push the limits of your
tastes and treat art on a whole as
organic and constantly evolving,” he
says. “How far can you push
something before you feel it start to
break? When you approach those
boundaries you're probably farther
than many others would dare to tread.”

In respect of his own art, shape and |
colour are a focus of Logan’s
experimentations, but stresses you can
realistically play with and find new
ideas in anything. “Drawing some
armour? Make the pauldrons
ludicrously big. Give that pirate
character 20 more parrots. Make that
sunlight 10 times brighter. You don't
know what works until you try it!”

TANTRUM

How do you paint angry yet
colourful characgr;:.’ This is.
Logan’s skill-His characters can -,
offer a range of emotions am‘ﬁu |
remain bright and engaging. *=
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| wanted to be part of bigger projects
| while continuing to live in Australia,
. he needed to go freelance.

“This affected my art by giving me a

: good reason to ‘stand out’ from the

. crowd. Online you're competing with
: the entire art world, so if your work is
. memorable, affecting and highly

| expressive you're more likely to be

STUDIO VS FREELANCE

Some of Logan’s desire to find a bold
style can be drawn from a need to
stand out from the crowd. Working in
studios around Melbourne proved
encouraging, but the artist says it pales
in comparison to industry hotspots
like Los Angeles. Logan knew if he

- remembered,” he confides. “Clients

| will feel like you're offering something
- to their projects that they can't get

| anywhere else. I think that knowledge
. encouraged me to push the

- boundaries more, because to even

| survive in the scene my work needs to

: resonate with a lot of people.”

\'\
N .
r
> &
»
¥ g™ 7&
i / 4
s - '}‘ rif
-
¥
g
“Part of a series of horror-
inspired monsters with the unusual twist
of bright colours and joyful personalities
not usually associated with the genre.”

' kk How far can you push
- something before you feel
it start to break? 14

Going freelance was a big decision
for Logan, but he reveals the work he
did in various studios laid the
groundwork for his move. The two
types of work have competing
demands. The life of an artistin a
studio is like a “pressure cooker” where
you're expected to deliver high
standards every day.

“You have constant deadlines and
a burning desire to prove yourself to
the team,” he explains. “These

CITY SKETCH

“Many of my artworks are
artistic experiments that
evolve into fleshed-out new
worlds. This is no exception!”

L

o

experiences helped increase my skills
exponentially in a short time-frame.
I'was pretty much drawing for eight to
10 hours every day and it was usually
stuff that intimidated me. Studio work
prepared me well for freelance life
afterwards and I recommend every
artist gain some sort of studio
experience early on, regardless of
whether they want to go freelance or
in-house in the long term.”

Freelance has its own pitfalls. The
biggest one, says Logan, is how many
artists undervalue themselves. He
admits to definitely undercharging for




Logan Preshaw

TANGO AND JiG

“Spawned from my
desire to create a
dynamic duo worthy
of a team-based hero
shooter. Doubles as a
loose homage to a
certain sci-fi video
game franchise...”

TING LIBRARY

was a challenge to create the
a.deep data repository

ling
and deslgn the enlgmatlc character
i [y

untry.”

his work in the past. His advice to new
artists turning freelance is to consider
everything in your fee. Every hour
should be accounted for, as well as
electricity, tax and superannuation.
Don't fear negotiation, either. “You
need to know what's fair, when to
push back and what you can
realistically live on,” he says.

REIN IN YOUR WORK HOURS

Maintaining a healthy work-life
balance is vital too. Without a studio
organising your time you need to
show restraint. He explains: “It's easy
when working on your own to go over
usual work hours, work through
nights, or not eat well. Maintaining
healthy sleep, eating and work habits
will increase your efficiency and

it'll take you less time to complete

work, as counterproductive as taking
breaks and sleeping longer hours may
seem at first.”

It's interesting to discover that even
with years of experience behind him
Logan’s not always good at taking his
own advice. The work he did on the
forthcoming video game Ark 2 was
the most satisfying in some time, but
was “highly intensive [...] I was
eating, sleeping and breathing that
project, [I was] just absolutely
consumed by it because I wanted to
get it right”.

The work on that game directly led
to landing his role as art director at
leading Californian creative
production house, West Studio.

Life as a pro artist, either studio-
based or freelance, is undoubtedly
stressful, but Logan has a clear =
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el SKYLINE

“Another piece from From In A Late
Country. The goal here was to
create the feeling of being trapped
in a sprawling futuristic city, with

freedom far on the horizon.”

»+ outlook to overcome the hurdles
thrown our way and stay creative.
“Take in life!” he states. “Inspiration is

everywhere, and sometimes all it takes

is ‘switching on’. When you step
outside, don't just take it for granted:
observe the light, shapes, history in
the architecture, the way people move,
the clothes they wear. Read books -
anything that interests you. Look at
some of your favourite artworks, but

kk Inspiration is everywhere,
and sometimes all it takes is

‘switching on’ 1%

i really look... dissect them and let them |
| take you in, reverse engineer them.

. I'm at my least creative when I forget
| to observe and be inspired by the

- small things.”

When it comes to creating his art

. Logan has some particular ways of

. working that can benefit all artists.

| Some of this comes from gaining the
right perspective. For example, he says
| the defining feature of sketching is

. confidence. “You aren't setting up for
. any big finales, so it's easy to commit
| to inaccuracy and looseness. That is

. fun to look at as a viewer, since they’ll
| see the possibility of the artwork as
 much as the art itself.”

Logan Preshaw

 ANY PLACE YOU WANNA 60

The rodent has the tickets you want: “Just a
painting for fun. Always great when | get some time
to do something for myself,” says Logan.

. Ifyou maintain this mindset when

. committing to a large painting you can
get into trouble. While sketching is
about invention and the promise of
something, painting complex scenes
requires a different direction.

Logan explains: “If you paint with
carelessness and inaccuracy early on,
that may lead to mistakes you need to
fix later. To solve this I break things
down. The more you can break a big
painting down into decisive chunks,
the less pressure you'll feel and the
. more confident you can be in your
execution. If you know what your first
stages are setting up for, it's easier to be
confident in them.”

FINAL THOUGHTS

Logan is the kind of artist who wants
to share and help other artists, and
just like his bright and positive
painting, his words matter. We ask
him what piece of advice he can share
that could make a difference, and he
leaves us with these words. ..

“You're in a massive gallery, and the
walls are covered with all the amazing
art that's ever been produced, today
: and throughout history. However,
there's a gap. On the far wall in front
of you, there's a space between all the
gilded frames and incredible artworks.
| That space represents the artist that
. would blow your mind... you would
. die for them, you're their biggest fan
and their work is everything you ever
wanted to see. Except they don't exist
yet — it's just a blank space.

“I believe we all have that ‘blank
space’, but it's different for everyone.

No-one's dream artist is the same.
| I think the most fulfilling goal you can
have as an artist is to fill that space
| with your own work.” g
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Feature

LAUREN BROWN

66 We're out here too and
there’s a lot of stuff that

we can do with these

characters and the way
we present ourselves 99

Inspired by nature, fashion and the desire
for greater diversity, this illustrator’s
reputation is sure to grow, finds lan Dean

himsical, ornate
and elegant,
Lauren Brown's
illustrations for
her own series,
humorously dubbed the nouveau
garden by the artist, are striking
interpretations of the traditional
art movement. Each one is themed
around an element in nature we all
take for granted, but in Lauren’s hands
becomes a window into a new world.
“The moment I saw Alphonse
Mucha’s work, I was just like, ‘Oh my
God, this is exactly what I wanted’,
because there was something so
beautiful about the graphic design
approach, but also the way that he
treated his figures as women. The
drapery of fabrics, the elegance... it’s
almost like royalty of how they were
framed by flowers.”
To get to that wow moment Lauren
talks like it was a turning point, but
revealing more about her artistic

Artist

PROFILE

Lauren Brown

LOCATION: Us

FAVOURITE ARTISTS: Geneva
Benton, Loish, Alphonse Mucha,
Sachin Teng and Claire Wendling
MEDIA: Pen and ink, Photoshop

WERB: |abillustration.com

o

journey it’s clear this was always where
she was meant to be. As a child Lauren
drew copiously from nature and

- sketched animals. T just loved
| everything: how animals worked,
- and how they moved and how they

interacted,” she says, revealing how she
would create stories and adventures for
them. Later, her interests took in

. fashion as well as fantasy art, and
| everything began to click.

| LIMITED IMAGINATIONS

There was something missing,
however, and that was herself.

| Growing up, Lauren never saw herself
¢ in the art she loved.

“I remember walking around halls

| of many conventions, looking at the
fantasy art displays, and just seeing no
. people of colour whatsoever,” says

© Lauren. “This is fantasy. Why wouldn't
. there be people of colour? This is the

| lowest common denominator of

. diversity you could put in these

. realms, and yet we just don't see any

| people who look like us. So a part of

- my aim is meeting people who look

! like us in those settings that I love

' to see. [...] We're out here too and

. there’s a lot of stuff that we can do

| with these characters and the way

. we present ourselves.”

The Mushroom Queen illustration,

' part of the nouveau garden series, =+




Lauren Brown

LOC JEWELLERY
out




Interview

# is representative of the artist’s
approach. This grew from an unusual
cluster of mushrooms Lauren had
spotted. Starting with a simple sketch
she began peeling apart the panicle to
craft the character’s outfit. Her own
hair and jewellery inspired the
Mushroom Queen’s long elegant locs
that mirror the mushroom stalks,
framing the character. Inspired by
Alphonse Mucha? Of course, but the

0CTOPUS MERMAID

“It's amazing to see
how much space there

characters or black

66 It was really important to
me to make a character that
had hair like mine... ®®

artist’s own life is represented in her
illustrations, too.

“It was really important to me to
make a character that had hair like
mine, because I just love seeing that,
and I love seeing that representation
in art,” she shares. “And I'd like to
represent people who look like me
and my art, because historically we've
been extremely underrepresented,
especially black women, in illustration
and fantasy illustration.” .

Even in her own art, when starting
out Lauren says she fell into the same

still is to create positive
representation of black

presenting characters.” 1

. trap of drawing largely white

. characters, which restricted her own
. imagination. That's what the media
| around her had reflected.

“It was interesting,” she comments,

. “because I look back at my younger
. self, and I'm like, ‘Why were you

. making these characters?’, but really
| I'wasn't to blame. It was just what I

- was exposed to.”

' DEALING WITH CRITICS

i The more of herself Lauren puts into

her art, the harder it could be to take

¢ criticism. But she’s become far more
philosophical about critique over the

| years. Life in a video game studio’s art
. team, and now as art director, means

| she can easily distinguish between

| constructive and destructive criticism.

“Every artist has gotten different

: criticisms over the years. I definitely

| have. It can be really hard at first

- because it's like taking a little piece of
. your soul and putting it on the table

- and telling people to look at this part

of me and tell me what you think

about it. It's basically thinking that

somebody is criticising a fundamental

part of who you are. And that can be

really painful for a lot of people.”
Now, she says, it's possible to

| separate herself from what other
. people think, and take on board other

people’s opinions. Yet that anxiety can
still creep in, and it was notable during
lockdown when Lauren examined

| her work. She discovered a lot of
: unfinished paintings and illustrations
- held back by her own internal =+



Lauren Brown

FRAMING THE
SPORECROWN QUEEN

The artist reveals that a love of animation is her secret
weapon to creating dynamic portraits...

2-COMPOSE MOVEMENT

"There’s usually a very clear line of direction
where the viewer’s eye goes when you see any

TDEFINE THE POSE
“| explore movement in
each painting like an
animation. [...] It’s basically a L % 3 =
sole frame of animation.” A SRR TS i il of my illustrations.”

3 USING PHOTOSHOP

“The graphic design aspects don’t come until the final part
of the process [...] | have a general idea of the framing | want
to use, but it usually comes at the very end once | have
everything else. It’s like, ‘Okay, now how do | frame this the
best way possible?’” And that’s where the last day comes in.”




Interview

TIEFLING

Inspired by Adeyanju Adeleke, Tiefling caused a stir:
“Why wouldn'’t there be a Tiefling with an afro?”

» critic. What would happen if she
finished a piece? Or completed it in a
way that didn't make her proud?
Would she let people down if her art
didn’t match up to expectations? The
anxiety was evident.

“I'was putting this invisible
expectations of myself, on my own
art, and it was holding me back from
actually producing more content,”
Lauren says honestly. “I've put that
pressure on myself to have to make
each piece the best of the best, or it has
to be my magnum opus, or it has to
be something that’s stellar enough
to be featured somewhere, or get, you
know, a certain amount of likes on
social media.”

The spectre of social media has
“definitely put a lot of pressure on

EASY RIDER

t of my il

ations, there’s
me kind of narrative being.

e I -and | want
to continue to be able to create that.”

66 I have this big world in my
“head that I haven't gotten a
chance to put out there 99

. many different artists,” she says,

. “including myself,” to create art that

- looks good presented in your online

. collection, in your established style, in
| anine-by-nine grid on Instagram. The
. life of a modern illustrator is fraught

| with anxieties. It's why Lauren set up

. the Painted In Color podcast, where

FAMILIAR

On Alfonso Mucha’s
influence: “I just love
that presentation of
‘women because it just
made them look so
elegant and powerful.
I took a lot of influence
and inspiration from
that influence.”

guest artists discuss their issues and
raise awareness of mental health
concerns, and offer advice. “It helped
me establish a better relationship with
social media,” she says.

WORDS AND PICTURES

Lauren is now working up her old
ideas, including the graceful Rose
Queen design that has sat dormant for
ayear. It’s ignited her imagination and
drive, too. She’s always loved exploring
narrative in her illustrations and

. explains every character she’s created
| has astory to tell - one that fits into a

broader project.

“I have this big world in my head
that I haven't gotten a chance to really
put out there. Part of my exploration is
really exploring that writing, exploring
that narrative, developing characters,
and developing a world,” she says.

Lauren is putting the same detail

.~ into her written words as she is the
| line-art that brings her queens to life.
The goal for Lauren is to create stories

where the language and beat of her
words match the whimsy and sense of
movement found in her art.

“It's going to be a process; writing is
really scary. But it's something that
I really, really love to do,” she says.

| “That's what one of my objectives are
* for the rest of this year.” @

JA= =
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WE ARE NOT PREY.. 44
“I'didn’t get any;traim‘ng‘ n how to
re?der dark skinjor how to texture hair
[.JAnd | think that's such a loss, because
_that’s such a big part of art.”
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LOCATION: US

L Dela has been working for
,,_ P over 10 years as a visual
,i,\ y development artist in
w5 video games and film for
h | . clients including Santa
L Monica Studio, Lucasarts and ILM. He’s
e currently the lead character concept ]
artist at Santa Monica Studio where |
Jkeletal
y of |
|

€,S ga\\ef ::'s:z;rkifnal on the next instalment in |
e God of 'ar game series.

hbook is @ de\'\ghtfu\ rog\ tering aliens. - antstation.com/delalongfish
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WANDERING WARRIOR

“One drawing always inspires other ideas
and what began as one character can quickly
turn into a cast of characters.”

~ SPACEPILOT

“Side-kicks and secondary characters allow
the opportunity to add visual variety to
your cast of characters.”

- SKELETON
CREW

“I tend to do muiltiple
explorations on a

66 What began as one
character can quickly
turn into a cast of characters %9

< —

character, exploring all
the different looks one
design could take.”




DAY OF THE DEAD

“Day of the Dead celebrations were a
big inspirations for these designs.”

QUEEN
OF THE
PUMPKINS

' “Being in the Halloween
mood, | was thinking
about what spirits watch
over the pumpkin
patches. | used twisted
vines and leaves as
inspiration for
her body.”

TRACKER

“Sometimes | start
with just a mass of
scribbles and see
what emerges
out of it.”

“I tend to jump around
between subject matters.
One day I'll be drawing
fantasy characters and the
next something more
sci-fi inspired.”




PUMPKIN
FAIRY
“Another version of

i a
character who keeps watch
umpkins.

66 I first started using
blue pencils while
doing animation

“Sometime | don't know
where ideas come from,
but | always love
seeing where they
endup”




~ Sketchbook Dela Longfish

~_FROG
 SAMURAI

“There are times
I have specific ideas in
mind for a sketch and
other times the designs
evolve on their own. This
started out with the idea
of seeing a frog with
asword.” .

 SKELETONS
" INHATS

| “Ifirst started using blue
pencils while doing
animation pencil tests
back in school and
never stopped
using them.”

/

“This set of drawings started out
with the idea of telling a California-
inspired ghost story based around a
group of skeletons. | even wanted the
car to look and feel like a skeleton
so it complemented the look
of the characters.” -

~ FROGWITH
"~ ASWORD

“l usually work on a few
drawings at a time,
bouncing back an fourth
between them

as | draw.” .

Do you want to share your sketches with your fellow ImagineFX readers? Send us an email with a
selection of your art, captions for each piece and a photo and bio of yourself to sketchbook@imaginefx.com

e A
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See page 6 now!

Workshops assets
FOR DIGITAL ARTISTS \ V4 are available...

Download each workshop's resources by turning to
page 6. And if you see the video workshop badge,
you can watch the artist in action, too.

Workshops

Advice from the world’s best artists

How to create
spontaneous art
Ayran Oberto paints a portrait
without overthinking anything.

From 2D concept
to 3D portrait
Character artist Anna Cavasos
balances beauty and horror.

Create retro art
from 3D scans
Ken Coleman mixes scanned
action figures and digital paint.

Apply CG skills
to a fantasy scene
Combine CG techniques with
photobashing, with Oliver Beck.

How to sculpt
a real dinosaur
Glen Southern breaks down his
ZBrush sculpting workflow.

b




Workshops

Photoshop

SPONTANEOUS ART

Ayran Oberto demonstrates the creative approaches he uses to
produce colourful portrait art without overthinking anything

Ayran Oberto

LOCATION: Spain

Ayran’s digital art
explores the stylisation
of the human portrait.
He also freelances in the
advertising, film and
video games industries.
artstation.com/ayran

When ImagineFX
I\ contacted me, I was

was to experiment
with a painting. This has always
been my mission with my personal
work, so I was more than happy to

approach the cover in the same way.

The idea was to paint a female
portrait and for this I went to my
comfort zone. My lines, which are
always flawed, tend to produce
features that I consider particularly

interested to hear that
the theme of the cover

attractive: thick lips, large eyes with
long eyelashes, small pointed noses
and hair that flows in all directions.

As with my other client work, I
start by visualising various options.
During this stage what's foremost in
my mind is to avoid drawing the
same angle. I look for natural angles
of the head that would allow for a
logical movement of the character’s
eyes towards the viewer.

Once the sketch with the strongest
composition is chosen, it's time to
give it maximum visual impact,

using colour. My approach during

- this stage is to create a sense of

. randomness using a range of

- Photoshop tools. I want to combine
- effects that on initial viewing appear

like mistakes, but with a little vision

. can end up having potential towards
. the end of the painting process.

Once the colours are finalised, it's

. time to enjoy discovering the image,

using design rules that enable me to

. reveal attractive shapes in each area
. that are gradually refined as the
| painting progresses.

oy X HOURSOF EXCUSVEPRO VIDEO TRAING % X HOURS OFEXCLUSVE PROVDED RAING

See page 6 now!

Sketching the ideas
It all starts with the sketch. A few key words spark ideas and help me write this workshop. My aim is to create different angles of a female
head using my visual and muscular memory, and give the viewer the sensation that they're being observed. =+

# agiiieRX




In depth Spontaneous art




Workshops

N

" > SN
Wrapping lines over my sketches
As I work on the sketches, I create geometric shapes using lines that seem to surround them. I need to visually feel the shapes and how

they change direction, which is dictated by the general angle of the face. With these geometries I seek to create features that attract me - the
thick lips, refined nose and large eyes that I mentioned earlier.

Finding the light spots Form shadows everywhere

To create the lighting scheme I think that the ideal approach is With the light already established I have an idea of how to
to centre the light so that all the characteristics of the face can be shade, as a result of using a more central light source. I focus on
appreciated in detail. I don’t want the face to become lost in shadow. creating form shadows on all the geometric shapes. One feature of the
To enhance the silhouette a little more, I draw a second light that central light source is that it doesn't create large shadow projections,
gently brushes the edge of the face. resulting in smooth transitions across the entire face.

$ agiiieRX




Exploring colour options
For this step I go to Layer>New Adjustment Layer>Curves. I switch between channels using Alt+2, Alt+3, Alt+4 With this brush | was
and Alt+5, and move the curve as I please, which creates colour breaks. Next, I double-click this Adjustment layer to Sbistopiethehaly

PHOTOSHOP

CUSTOM BRUSHES:
INK COLORVARIATION

| used this brush to
sketch with. It has a
natural ink feel to it.

CREAMY ROUND

This brush is useful

for making the first
shading pass and
creating soft transitions.

CREAMY ROUND
SOFT EDGE

1 used this for making the
second shading pass. The
soft edge helps to mix
the tones.

volume and richness.

determine how much it blends with the one below in the Layer style>Blending options menu.

x|

Creating a variety of colours

I focus on identifying the potential of each of the results from the previous step. Using the Color Picker, I select the colours that emerged
and bring them to other areas of the face by applying brush strokes and taking each of the options in slightly different directions. =+

litiagifie X %
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\i 0 Let the game begin
. The colour option has already been approved and
Combining the options I'm still aware that there are many errors that [ must

The art editor likes two colour options: one with a yellowish-blue palette and  correct to bring the image to its maximum expression.
the other one with a more saturated skin tone. I place the saturated option on a The most difficult stage has been overcome and now I
layer beneath the other option and erase the face of the layer on top. This reveals can start jumping in all directions. I fix and give
the saturated face and achieves the best combination of the two options. definition to all the chaos that's still present in the image.

Breaking down the big parts
0 The sketch is the record of a very general idea and
Contrast and duality each element of the portrait itself is a simple one. Much

+,

To balance the image I need to think in terms of contrast, which extends to like a rendering engine that subdivides clustered pixels to
more concepts than just value contrast. My intention is to create a lot of life and increase definition, I decide to break all those elements
information in the hair so that the softness of the face stands out more. In addition,  into smaller ones. This will increase the feeling of high
the eye of the viewer will naturally try to settle on these areas. definition within the illustration.

# agiiieRX




In depth Spontaneous art

Everything flows
In this step I check that the lines of the image

always guide me towards the face. The curved lines are Liquify without remorse

an excellent tool for this: in addition to supporting the I use the Liquify tool to correct elements that have already been refined. I
viewer's gaze, they can also be used to generate a move them while checking the thumbnail to achieve a more coherent positioning
sensation of movement, removing any possibility of the of the facial features and hair. For this I go to Filter>Liquify, click the Forward Warp
illustration coming across as static and rigid. Tool on the left-hand panel and push the forms as required.

Picking out the highlights
To give a final touch to the image, I create a new 4
layer and set the Blend mode to Color Dodge. Then I Letting go of the illustration

apply very soft strokes with a neutral, desaturated colour I can't deny that all the work I do for clients increases my nervousness, and
over the highlights with the Soft Airbrush from my that as a consequence I find it difficult to know when to stop adding details. If I

custom brushes collection, slightly increasing the unreal ~ can't control myself at this stage, I may end up destroying the image. The solution
magical tone and quality of the light. is to draw on my experiences, send the file as finished and wait for feedback. g
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Maya, Mari & Photoshop

FROM 2D CONCEPT
TO 3D PORTRAIT

Character artist Anna Cavasos balances the themes of beauty and
horror to visualise a mysterious sorceress enjoying a delicate snack

Something draws me
to the contrast
between pretty and
repulsive. That's what
initially caught my eye
with Lena Richard’s concept piece
(lenarichards.artstation.com); the
woman was beautiful enough to
capture your attention, but what she
was doing was so gross you couldn’t
look away. As a student, I was

Anna Cavasos
LOCATION: US

Anna is a 3D character
artist and recent
‘Gnomon graduate based
in Los Angeles. She
creates pieces varying
from stylised to realistic.
annacavasos.com

How | create...

A CUSTOM
PATTERNED
FABRIC

searching for a concept that would
give the most intrigue.

This piece starts with the sculpt. I
look at classical beauty Emilia
Clarke, whose features would work
well contrasted with the scars. When
considering the robe, jewellery and
props, I want to go for the essence of

a mysterious sorceress, whose
intentions are unknown. I want her
to have hand-carved wooden props,

2 Creating the seamless texture

real gold jewellery and a beautifully
embroidered fabric to all tell a story.
I also want to show her skin being

pale and discoloured, as if she resides
deep in a cave, and the viewer has
just stumbled upon her. I study
cave-dwelling animals and albino
humans. Albino skin has the lack of
red that I need, but the patchiness
and translucency of salamander skin
was necessary for the creepiness.

| scan the fabric and import it into Photoshop. Using the Offset tool and with careful
painting, | create a black and white mask that can then be taken into Substance Alchemist.

Finding the perfect fabric

| search online for a fabric texture, but
can't find the right one. | decide to search a
few fabric stores, and end up finding this
brown floral print. Knowing | only needed
the perfect pattern helps me to whittle
down the examples to the one that works.

3 Using Substance

Alchemist

In Alchemist, | use a base fabric
with a small thread count and
coppery colour. Using the mask
that | created earlier, | make an
embroidery layer that has a large
thread and lower roughness. This
creates a nice breakup in the
specular pass.




Her animated head glow is
done using Nuke. | paint a floral
black and white pattern in
Mudbox, and assign it as a
V-Ray extraTex pass. | multiply
it with a Noise node in Nuke and
then animate it so it has some
slow movement.

| texture the skin using scans
from Texturing.xyz. Using Mari,
| projection paint the
multichannel displacement
maps and albedo maps (using
the Paint Through tool). | make
adjustments to ensure the skin
is nice and pale, as well as add
veins and blotchiness. In Maya,
| use V-Ray’s AlSurface material
for the subsurface scattering.

| sculpt these in ZBrush, making
a high poly mesh and a lower
poly. I sculpt the veins and
breakup, so that the specular
would catch those details. The
specular map is an opalescent
colour, and the material is a
blend between a normal
material and a subsurface one.

The hair is done in XGen. The
braid is done with a tube
groom, with three cylinders
braided around one another.
The eyebrows and eyelashes
were lighter to evoke a sense of
albinism and unify the portrait.

Her sleeve, hood, and braided
jewellery are all achieved with
MASH inside Maya. | create
simple small meshes that would
capture specular well, and
place curves where | want
them. | also create a few
variations so they wouldn’t
look repetitive. MASH is great
for modelling quick random
forms like this.

Less is more when it comes to
lighting. It's hard to hide parts
of a piece you're proud of, but
the viewer can fill in the blanks.
It also tends to add more
intrigue when you can barely
make out what'’s there.
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CREATE RETRO ART

FROM 3D SCANS -

Ken Coleman mixes scanned action figures and digital
painting to create 80s-inspired fantasy production art

Ken Coleman
LOCATION: Ireland

Ken lectures in game art
and design at Clonmel
Digital Campus in
Ireland. He also designs
for clients such as
Catalyst Games and
Morbid Angel.
artofkencoleman.com

Combining my love of
i| customising action
figures and kit-
bashing 3D models
for concepts is exciting
for me. Over the past year, I've
developed a library of 3D scanned
assets, including character heads,
armour and weapons to composite
scenes of my favourite characters
from the world of He-Man, Skeletor
and the Masters of the Universe.

The vintage toy box art, 80s iconic
movie poster art and Frank Frazetta
are strong influences on the type of
finish I go for in my nostalgic
imagery. In this workshop I'll
explain my process, from how I
3D-scan and prepare the models,
before importing them into ZBrush.
I'll show you how to use basic
ZBrush navigation tools such as
Gizmo, Transpose, Subtools and
Brushes to build a character,

combining a model I previously

- posed and exported in Daz 3D.

The workshop will continue on

* the lighting and rendering of

. different passes of the model in

| KeyShot. These KeyShot renders will
. then be combined in Photoshop to

. build an image mixed with my own
- hand-painted backgrounds and

. textures and then given a final

paintover in Corel Painter to get that

© 1980s-style oil-painted finish.

Preparing for the 3D scans

I prepare a figure in Daz 3D - I have a favourite for my Masters of the Universe projects
called Dark Guard. I combine him with some animal and beast morphs to get the clawed
hands and feet. I then export this as an object file to be used in ZBrush. [ scan the various parts
of the figures with my EinScan-SE 3D scanner. The larger-scale models are great for detail on
the face, but the armour parts on the seven-inch scale figures are perfect for blocking in 3D.

Building the ZBrush figure

I import the Daz 3D model into ZBrush
and press T to make sure the model is
functioning in the 3D space. Using the
Subtool palette on the right of the screen I
duplicate the figure and press Import. I select
the 3D scanned elements by repeating this
process. Every time I duplicate a Subtool and
press Import, the new model part will replace
the previous one in the composition. I have
to be careful to scale the 3D scanned parts
using the Gizmo and Transpose tools - not
all scanned parts are correct when imported.

)

See page 6 now!

Lighting in KeyShot

To import the model from ZBrush to
KeyShot, I go to the Render menu, select
External Render, turn on KeyShot and then
press the BPR button. This will import the
model directly to KeyShot. Once the model
appears in KeyShot I go to Edit>Add
Geometry>Sphere. I can then make a light
source. To do this, I double-click the sphere
model in the scene window in the top right of
the screen. When I click the light bulb symbol
that opens beneath it, I can change the
material to Area Light>Set to Watts. »»




p “pih Retro art




Workshops

~Lidhs

|
b
e

Materials in KeyShot

KeyShot enables you to drag and drop a
material on to any of the separate Subtool
elements to colour it. You can also apply a
material to the whole model by dragging the
material over to the Scene section and
dropping it on to the ZBrush label, which is
the model and all its elements. If you do this
you must press the Lock button in the bottom
window twice and Press Unlink Materials to
add different materials individually.

-

Face lift with Camera RAW

Photoshop’s Camera Raw filter is a
powerful tool for adding a degree of punch to
your illustrations. Select the top-most merged
layer copy and press Filter>Camera Raw
Filter. You can see from the image how I've
placed my sliders. My approach is always
Shadows up, Clarity up, Saturation up slightly
and Highlights and Whites down. This extra
tweak really gives a burst of colour and detail
to your 3D render.

o

List of KeyShot materials
I use the same materials apart from the

character colours to achieve the right look and

translucency of light. Skeletor’s face is bone,
his skin is electric blue and I use metallic and

non-metallic colours for his armour. The other

KeyShot materials are GOZ Human Skin and

Blue WHITE RIM LIGHT. I export each render

as a hi-res PSD file with the clown option
turned on to create a silhouette to use for
selections in Photoshop.

Adding texture and detail
I find that using photos of rusty
surfaces and stained concrete are fantastic
for creating detail and depth in images. The
concrete and porous stone is my favourite
textures for the skin. I drag these elements
on top of the figure and I mask them using
the silhouette from the clown layer that I
exported from KeyShot. My painted Polyfilla
layer is especially useful and fun for creating
a bone-like effect on Skeletor’s face.

Combining the layers
Once my renders have completed I
open the basic colour one in Photoshop.
Next, I drag the other layers into this file as
Smart Layers. I set the GOZ layer and Blue
Rim layer to Soft Light Blend mode. Once I'm
happy with the level of translucency of all my
layers, I select them all, copy them and merge
them (the shortcuts are Ctrl/Cmd+] followed
by Ctl/Cmd+E). I duplicate this layer one
more time for the next phase.

Composing a layout

Now that I'm happy with the overall
figure, I group all the elements. I create a new
file the same size as an ImagineFX page at
22x30cm but at 450dpi for higher resolution.
Most of my work is at least A2 in size at
300dpi. I now drag the figure group across
and start to place background elements and
particles to build a scene. I have folders of
hand-painted backdrops, particles and
objects to help build scenes quickly.




Hand-painted backgrounds

I add stock photos of some Irish coastal
landscapes and one of my hand-painted
backgrounds. I'm lucky that there are many
local landscapes and textures to help enhance
my work. Using my local environment in my
art is important to me. My hand-painted
clouds were created on various large canvas,
photographed and combined in Photoshop
to create a set of various backgrounds that I
can drag and drop into my art.

Breaking up the image in

Painter or Fresco
You can save the file to the cloud so you can
open it on an iPad and use blender and fine
art brushes in an art app such as Procreate or
Fresco. However, I choose to use Painter on
the desktop. I use a limited number of
Brushes on the merged layers. My favourites
are Stencil Oily Blender and Fractal Blender. I
also place some white or brightly coloured,
thin highlight lines on a new layer with the
Spring Concept Creature brush. Shown here:
the before and after versions in Painter.

Adding my own particles
I create my own particles by taking a
photo of baby powder on black craft paper,
as well as creating particles with Painter’s
Particle brushes. I add these elements by
placing them in the scene and setting the
Blend mode to Screen. I also create gradients
of green by selecting the colour from the
glows on the 3D figure’s body. Using the
Gradient tool and cloud brushes I create
directional light that matches the model.

Finishing up in Photoshop

I reopen the image in Photoshop and set the highlights to a Soft Light blend mode. I also
experiment with the Opacity of the painted layers and sometimes mask off areas where I may
have gone overboard with Painter. The idea is to balance the abstract brush work with the
detail and silhouette of the final image. Sometimes I merge and duplicate everything on one
final layer and use an Unsharp mask set at 200 per cent at 0.2 pixels for clarity. Finally, my 3D
scanner is costly, but try experimenting with smartphone apps such as Bellus3D and LIDAR

In depth Retro art

Final prep before paintover

Before bringing the composition into
Painter for a paintover, I click Image>
Duplicate to create a copy of the file. I select
the figure’s outline, then flatten the image
and copy and paste just the figure over itself.
I now have options to use Blender brushes on
the figure and background separately in
Painter. Using large oil brushes for the
background and more refined fractal brushes
for the skin gives a nice sense of depth.

3D to create 3D models of everyday objects to use in your artwork. g
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Artist
PROFILE
Oliver Beck
LOCATION: Germany

Oliver is a freelance
concept artist and
illustrator. When he’s not
working for clients he
enjoys finding new
challenges in his
personal work and
improving his art skills.
ifxm.ag/oliver-b

N

When it comes to

personal work I rarely

have a clear idea of

what I want to do. I

constantly carry out
small experiments here and there,
and sometimes they evolve into
something larger.

Before I started this artwork I had
been exploring foliage scattering and
creating vegetation in CG for a

yuple of weeks, and decided that it

e to bring everything I had
| together in a larger piece.

In depth 3D detail

Eighty per cent of the foliage in this
illustration was done in 3D, and it
. was surprisingly straightforward.
| Aside from pushing my technical
- skills I wanted to create an artwork
. with a sense of adventure. I love
| portraying huge architecture in my
. art, usually with a touch of fantasy
| ora bit of a Dark Souls vibe. I've only
i recently begun to get into characters,
. which gives me better opportunities
| to tell stories and incorporate
: storytelling in my pieces. So I
| thought it was about time to bring

. these two elements together. I'm

very excited by the possibilities

- this approach opens up for future
| artworks, I'm sure that this piece is
- only a glimpse of what is to come!

For now, though, I'm looking
forward to continuing my work in
the realm of fantasy environments.
I've been reading The Silmarillion
- the origin story of Middle-earth
- and am very inspired by Tolkien's
tale. Maybe I'll illustrate a scene or
location from the book for my next

| work, but no promises yet!




SAVING TIME IN 3D QY sumospheri touches
I like to incorporate fog and atmosphere
& = in the later stages of the artwork. I'll
X l x 3 mask out an area, then apply
- brushstrokes with a low Opacity and
using the Smudge tool to refine the
edges. The detail in the architecture was
added by masking and using various
blend modes on my ambient light render
pass as well as photobashing.

f : J 1 Reusing a side-project
4 | £ The statue with the missing head is a side
experiment done in Houdini. | bring in one
of the statues, remesh it, and split it into
parts using the Voronoi node. | could have
just removed the head by painting over it,
but | love doing these small experiments
and Houdini is always a lot of fun to use.

Make a difference

One of the most important steps to
finalising the image is applying some
post effects. Motion blur, noise,
vignettes and lens flares can make a
world of a difference. Experiment with
them on different layers and see what
you can come up with.

PHOTOSHOP

CUSTOM BRUSHES:
TWO-SIDED

I’'ve been using this brush
for as long as | can
remember. It can handle
pretty much anything
you throw at it.

JUICY EDGES

This brush is great for

applying final touches The details matter
on fog, waves or grass! To make these little guys | pose some characters in Daz3D,
But don’t overuse it. give them basic clothes, and even swords (although you can’t

Both of these brushes see it here). They’re cautiously walking up the stairs ready to
are from One Pixel Brush defend themselves. The torches were created in 3D, with an
(onepixelbrush.com). image of flames used as an emissive texture.




Create the water
The water in this image is, aside from a few brushstrokes and
colour adjustments, fully 3D. | create a simple material in Octane,
using the internal autogenerated noise texture in the Bump and
Roughness channels. | then adjust the Noise settings until | achieve
a result that I’'m happy with - easy and quick!

Composing the scene

| utilise the characters as well as the
foreground elements to lead our eyes to the
focal point of the image, wi the
bottom of the staircase. This is additionally
framed in a window composition by the
broken pillars in the image’s centre. All of
the other elements either point towards, or
lead the viewer back to this point of interest.

Photoshop tweaks

| The 3D render gave me a great headstart

. on the foliage. Later on | used some
motion and Gaussian blur effects as well
as the Smudge tool to remove the detail
and sharpness from the Render. In some
places | used the Mixer brush or cloned
existing elements to make the foliage
more dense or to add variety.

In depth 3D detail

How | compose...

A DRAMATIC
ENVIRONMENT

| Quick blockout using Blender
| start with a quick layout in Blender. | use some
pre-made assets for the architecture, stretch out a
couple of ellipses for the terrain, and place a simple
plane for my water material. | later add some boats from
another project for scale and storytelling purposes. I'm

just looking for an idea and a striking composition.

2 Materials and lighting
| import my Blender model into Cinema 4D. |
make use of Cinema 4D and Octane for most of my
artwork. | establish some basic materials, add fog and
create a quick lighting setup. If you have a good
composition, this can get you pretty far and give you a
good idea if the image is heading in the right direction.

W

e ——

3 Final render

This step involves the most amount of work.
| expand the temple structure, add characters and
foliage, refine the lighting and materials, and set up
passes for the final render. What you can see here
doesn’t involve any painting or photobashing - it’s all 3D
with some quick colour grading! Don’t be afraid to
embrace 3D tools and techniques in your 2D art.
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A REAL DINOSAUR

Glen Southern breaks down his sculpting workflow and techniques
when tackling a concept sculpt of an aquatic, aggressive dinosaur

Glen Southern
LOCATION: England

Glen runs SouthernGFX,
a character and creature
design studio. He’s been

using and training
ZBrush for more than

15 years and is a Wacom
Ambassador. Recently,
he’s been creating in the
VR space working with
companies like Adobe
and Gravity Sketch.
southerngfx.co.uk

] ZBrush is my favourite
sculpting package by
far, but people can
find it intimidating
when just starting out.
Here I show how to tackle creating a
large dynamic dinosaur sculpt.
There are so many ways to start a
project like this in ZBrush, and there
are lots of confusing tools and
feature names like Dynamesh,
ZRemesher or the popular ZSpheres.
To get you up to speed and simplify
the process, I'm using the most basic

of techniques, which is to add simple
primitive shapes to block-out the

primary form and then use just three |

or four of the most popular Brushes
to add detail. Understanding this
sort of workflow, where you block
out primary forms and pin down
scales and dimensions, then focus
on secondary forms (which includes
large muscle groups and major
landmarks) will help you grasp the
fundamentals of ZBrush.

The final step (tertiary detailing) is
the one that I love the most. It's

where you get to add the finer details

- such as scales, wrinkles, pores,

creases and cracks in a large
dinosaur’s skin. I've made alpha

- images to use with the detailing

brushes and I include them with this

. workshop's resources. With a range

of detailing alpha-textures you can
really make your sculpt ‘pop’ off the

. screen. Whether you go on to paint-

over the model for an illustration or

. use it as part of a 3D print project,
. you'll have some amazing details on
' the underwater creature.

Reference is king when creating realistic art

Collecting references is how to make something believable. I use a mix of references for this version of a spinosaurus and I start with a
skeletal image. In ZBrush you can add your reference to the model rather than to the Viewport window. I decide I would only need a back
image, not a full set of back, side and top. The reference images can be added at the bottom of the Draw panel as shown. 3+
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Different ways to create
There are many ways you can start a model in ZBrush. I was going to use something called ZSPheres - a kind of a virtual clay that contains

no geometry - as a base, but decide that building up the form using primitives (simple pre-made shapes) is a better way. I add two spheres and a
plane, move them to match the reference images and then used a feature called Dynamesh to merge them all together and remesh them.

Primary forms

Primary forms are the building blocks that we use
to start creating. They help to establish the overall scale, Add basic limbs to the body
length, volume and shape of a sculpture. I use a limited For the limbs I add basic Cylinders from the Tools menu. I use the same
amount of ZBrush brushes including Move, Clay brushes to pull and shape them and I keep the Dynamesh feature on so that I can
Buildup, Flatten and Inflate. I drag the geometry around ~ remesh the model as needed. Dynamesh is in the Tool menu and is activated by
to match the reference and also kept looking at it from tapping with your stylus (assuming you're using a graphic tablet) and is perfect
the top to make sure it's reading well from that angle. for free-form sculpting.

% ImagiieFX
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Generate a separate jaw Move into secondary forms

The head is the most dynamic part of this creature The initial reference I use was a skeleton and it gave
and as such I'm happy sculpting him with a closed me a good start. The plan is to sculpt the spinosaurus in a
mouth. I mask off the lower jaw and separate it from the ~ neutral pose so that I can sculpt symmetrically (X) and

main body (I use Split-hidden in the Geometry panel). leave the posing until much later. At this stage in the
With a separate jaw you can try different poses easily and  project I'm still looking for the primary forms, but
really focus on the corner of the mouth, which is a crucial ~ beginning to think about the next part, which is about
part of the design. forming the secondary details such as muscle groups.

Be sure to sculpt around an eye,

One tip is to always sculpt around something that’s going to be there eventually. If you try to sculpt an eye
without any geometry you may make it look unrealistic. From the Tool menu add a poly sphere and scale it to the
right size for the spinosaurus. Mirror it across with Geometry>Modify Topology>Mirror, and Weld. Now you can
sculpt the eyelids more accurately and with confidence. =

CUSTOM BRUSHES:
SCUTES

1 add a range of 50
alphas to the pack.
Scutes are the hard,
bony plates on the back
of the dinosaur.

A well-used brush that’s
just for adding basic
scales down the body.

CREASES

Crease brushes help to
put some deep-score
lines all around the
creature’s underbelly.

OSTEODERMS

Osteoderms are like
scutes and are found
mostly on the back of
the creature.

linagine X $
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0 reate the dinosaur’s toothy grin
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To sculpt the teeth I again use a primitive sphere and then use Dynamesh on it. Now I use the Move brush and the Flatten brush and keep
smoothing it down until I reach the desired shape. Flatten gives a realistic look to the edges. If you go too far in reshaping, use Inflate to bring
back some volume then re-Dynamesh the resulting mesh. Continue this process to build and shape the teeth.

Position the teeth

In the Sub Tool panel start duplicating the teeth and repositioning them to fit
your design. Don't forget to look at more references to make sure you're making a
realistic set of teeth for a spinosaurus. Once you've done a full side, merge them
together and then use Mirror-and-Weld again to flip a copy across. Repeat this step
for the rest of the teeth.

Build up the creature’s form

around the teeth
At this stage we're well past primary forms and looking at
major muscle groups and specific areas of skin. Pay
special attention to the corners of the mouth, the lips and
the volume in the muscles that close the jaws. Don't do
any surface detail - rather, just try and get the overall
shape to look right. I add a tongue at this stage to achieve
a fuller sense of proportion.




Adding the limbs

I add hands and feet by making separate digits
from primitives following the earlier process, then I
merge them together. I make one hand and one foot and
mirror them for speed. I then Dynamesh them into the
main body by merging. Once all the limbs are part of the
main mesh I use Smooth and the Clay Build-Up brush to
fix the joins and unify the sculpt’s elements.

In depth Sculpt & detail

Use ZRemesher to create a low poly version

To be able to pose I need a low polygon mesh. To do this I use ZRemesher in
the Tool>Geometry panel and set the level to about 10,000 polygons (10). This
gives me a decent low poly mesh to work with. I then subdivide it a number of
times and use Project from the Sub-Tool panel to add the high-resolution detail
back into the sculpt. This means I'm now ready for the final skin details.

i

Using Alphas to add details

Black and white Alpha maps are a great way to add surface detail. I'm sharing
all of mine with this workshop. To add them in, import them into the Alpha panel
via the Export button. Now use the Standard Brush that'’s set to Drag-Rectangle in
the Stroke Panel. Change the Alphas to suit your need and add cool surface details.
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Introduce some colour

The final step is to add some colour. No one really knows what a spinosaurus
looked like, so you can go a little crazy here. I use the Standard brush with some of
my alphas and I change the colours a lot over the surface of the creature. I keep him
dark on top and light underneath. This is called countershading in nature. I pose
him in different ways using masking on the lowest level model. I use the model in
several projects including painting over for this workshop and also a 3D print.

Place the model in an environment

I generally do a lot of over-painting on projects like
this. I take the final renders right out of ZBrush and I
composite them in Photoshop. If I need different
background elements I'll either render other models and
add them in the background or paint them right there in
Photoshop. I use a lot of reference material when I'm
doing this stage. It all depends what the final image is
going to be used for and I often use stock photography to
enhance my compositions. g
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78 Painter 2022

Corel's painting tool still targets those who
are serious about being painterly, but
makes concessions for beginner artists, too.

BOOKS

80 Creating Stylized Animals
Learn how to walk on the wild side

and make your animal character art stand
out from the herd.

81 My Neighbor Hayao:
81 En Plein Air: Light & Color Art Inspired by the
Take your watercolour art outdoors with the ~ Films of Miyazaki
help of this book, which even advises what = See how artists reimagined Studio Ghibli's
to pack for a plein air painting session. animation work for a popular exhibition.
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Painter 2022

MARK MAKING Corel’s flagship digital art software still targets those who are
serious about being painterly, but makes concessions for beginner artists, too

Price £360 (£180 for upgrade version), £159 for 12

ainter 2022 continues
Corel’s goal to simulate
the use and feel of real
paint. There are few
programs that can hold a wet brush
to Corel’s software, so what’s new?
An overhaul and, some might say
unnecessary, reorganisation of the
Brush library is the first thing that
grabs you. It’s perfect for beginners
though, because every brush is now
alphabetised and re-ordered into
easy-to-remember categories.
Better still, use a filters search such
as Watercolor Compatible and hey
presto - a list of every compatible
brush from every category appears.
You can now add the texture of
wetness to dry media brushes,
directly on watercolour layers, too.
The possibilities just rocketed in terms
of experimenting with mixed media.

o

Want to try your hand
at oils, but worried
about the mess and
expense? Painter 2022
can help.

Another handy addition to the

i brush library is the Like button. You

. can keep a selection of your favourite
brushes at hand in a custom palette,

: and the Brush Size library gives you

| easy access to your most-used sizes. If
¢ you know what you usually need

. before you start painting it's now even
| easier to have everything at hand. If

The latest version of Corel Painter
enables further customisation of
its watercolour brushes.

th subscription Company Corel Web painterartist.com

. you draw comics for example, you

{ may only use a couple of sizes and

. brushes to ink your art - now, your

| custom palettes mean your workflow
: is even smoother.

If there’s one overriding upset when

it comes to making digital work of any
kind, it’s that a digital painting can

look, well, too digital. Some valiant

- efforts in replicating impasto mark

. making, or the wetting and drying of

| watercolour on textured paper, have

. been made over the years with Corel
Painter, but the introduction of stamp-
| type brush customisation heralds a
sharp increase in what's possible with

lBWiLeIL Yeissar AQ Ly

variation in mark making.

With an overhauled Dab library you
can change the Dab effects of your
favourite brushes, bristle by bristle,
giving you much more of a painter’s
hand. Putting an end to repetitive
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W Fie Edit Carwas Laers Brushes

Improved layer
management is just
one of Painter 2022's
workflow tweaks.

strokes, you can edit Dabs on the fly
using slider changes, giving you all
the variance you could need in any
single brush.

Another noteworthy addition is the
ability to view your work in greyscale
via the Navigator panel. This works
wonders for getting those tones and
values right, much the same as being
able to view a mirror image of your
work - so you're getting your eye in
compositionally. These are age-old

Select Shapes Effocts Movie Window Help

‘heavyweight’ painting techniques can
seriously eat into your memory and
graphics processor, but the Brush
Performance Accelerator you're
presented with on launching Painter
does a fine assessment on how well
the program will run on your setup,
and offer handy suggestions as to
how certain upgrades or tweaks might
benefit your user experience. It shows
you how well your baseline, CPU, and
GPU are contributing to brush

66 With an overhauled Dab library you
can change the Dab effects of your
favourite brushes, bristle by bristle #®

artistic tricks, but it’s nice to see that
Corel is taking a forward-thinking
approach by looking back. A second
screen works best for both of these

painting methods, but isn’t mandatory.

PERFORMANCE

Painter 2022 is heralded as the fastest
version of the program. The GPU
acceleration, added in 2020, has been
tweaked to deal with those new and
enhanced brushes. Some of those

performance, offering you a score in
red, amber, and green.

Because Corel Painter is aimed at
replicating real media in immense
detail, the program will clearly put a
strain on your system’s resources. If
your budget limits you from
immediately purchasing hardware
upgrades, we'd recommend not
running much else in the background.

For serious painters and wannabe
serious painters alike this is a well-

Features

W Stamp customisation
mRevamped
watercolour brushes

W Refined brush library
and selector

M improved workflow
W Greyscale navigator
W Better Layer system

System
Requirements
PC: Windows 10, Intel
or AMD 64-bit CPU,
8GB RAM, 3GB HDD
Mac: Big Sur 11.0 or OS
10.15, Intel or M1 CPU,
8GB RAM, 1.5GB HDD

Stafan Kelin

priced one-time purchase, or an even
cheaper upgrade from an earlier
version. An affordable annual
subscription option will suit those who
can't afford the up-front cost. There’s
a free 15-day trial available if you are
unsure about taking the plunge, too.

If you're serious about capturing the
look of traditional media in your digital
art then this is definitely the software
to go with. Slick upgrades to brushes
and Dab customisation means greater
variance in painterly mark making,
ensuring that Corel Painter 2022 is still
a pioneering - and affordable - digital
art platform. Screen mirroring on an
iPad Pro is a nice way to use the
venerable program, too. g
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Reviews

Anthropomorphism - giving
a non-human object human
characteristics - is covered
in-depth in the book.

-

y

Creating Stylized Animals

MARVELLOUS MENAGERIE Learn how to walk on the wild side
and make your animal character art stand out from the herd

¢

Editor Marisa Lewis Publisher 3dtotal Publishing Price £30 Web 3dtotalpublishing.com Available Now

hether it’s for an animation

project, a children’s

picture book or a line of

posters for your Etsy store,
being able to design animal
characters with visual impact is a
skill worth learning. 3dtotal
Publishing’s guide aims to sharpen
those skills.

The book’s first 80 pages contains
chapters that cover core animal
design and illustration topics. These
include boosting character appeal,
drawing faces and expressions, and an
overview of anthropomorphism.

Each topic is explored in-depth by a
different artist, which adds visual

: The eyes have it -

! Nathan Pangilinan’s

| chapter covers how to
. stylise animals, such as
i their facial features.

! variety across this section. Better still,
: the visuals are backed up by detailed,
clear advice that takes the form of

| explanatory paragraphs, extended

. s captions and standalone tips. In

ma . Gervais Merryweather’s chapter
on gesture and pose he passes on

: numerous insights gleaned from his
. career as a freelance animator.
| Meanwhile, the jaguar rockstar that’s
concepted, stylised and refined by
. César Vergara is only a gig away from
© their own children’s streaming show.

66 Being able to design animal
“characters with visual impact
is a skill worth learning %9

The main portion of the book sees
| seven artists take on an animal-
themed project. They're led by two-
. word prompts - ‘villainous hyena’ and
© ‘greedy pony’, for example. Each artist
. follows the same structure: they start
- with a mind-map of related words,
before going on to tackle research,

. expressions, poses, and values and
i colours. The artists doesn’t stop there,

- thumbnails, basic shapes, details, facial :

V?’ v‘c‘:\

Tata Che’s snowy owl is delivering warning letters to

. naughty children in the lead-up to Christmas.

hough: they all take their finished
conventional animal design and give

it the anthropomorphic treatment.

Sometimes there’s a bit of a
disconnect between the four-legged

. design and the two-legged variant,

but there’s plenty of good advice on
offer nonetheless.

Creating Stylized Animals concludes
with shorter animal projects, an

. extensive list of idea prompts and

biographies of the 19 contributing
artists. Credit to editor Marisa Lewis
or marshalling their collective talents
or this enlightening guide.

RATING % %Kk k37




Inspiration Books

En Plein Air: Light & Color

AIR BRUSH Take your watercolour art outdoors with the help of this
book, which even advises what to pack for a plein air painting session

Authors lain Stewart Publisher Walte

he warmer weather of the
summer months are a
great incentive to practise
your art in the great
outdoors. The expert advice within
En Plein Air: Light & Color aims to
make your time outside your studio
more productive.

lain Stewart sketched
and loosely painted this
Scottish harbour scene,
before refining it back
in his studio.

ster Publishing Price £15 Web quarto.com Available Now

The subtitle of lain Stewart’s book

r . refers to watercolours. lain shows how
. . to capture a variety of outdoor

¢ locations in this challenging medium

! - ranging from New York’s Times

| Square to a shipyard in Gothenburg.
Yet a good portion of the book is also
. devoted to sketching the scene, ready
" for painting. The artist explains how to
. visually simplify a location, identify
perspective, action lines and more.

¢ Despite the book’s selling itself as

. suitable for beginners, the tone and
language feels more suitable for
intermediate artists.

lain’s coverage of watercolours

" backs up this impression. Alongside

. practical advice on the nature of
watercolours are workshops on

* painting outdoors, but there are also

. general artistic insights that will chime
| with more seasoned illustrators.

et ».

lain explains how he simplified and selected the

. colour palette of this Amsterdam street scene.

The author’s experience as a

- watercolour instructor is evident.

. There’s plenty to discover in this book.
. It covers a lot of ground, but in a

. manner that always feels encouraging
© rather than overwhelming.

;mume****ﬁ

My Neighbor Hayao: Art Inspired
by the Films of Miyazaki

NEIGHBOURHOOD WATCH See how Studio Ghibli’'s animation work
was reimagined by a variety of artists for a popular exhibition

Author N/A Publisher Cernunnos Price £22 Web abramsandchronicle.co.uk Available Now

ayao Miyazaki and the work
of Studio Ghibli is
celebrated in this
compact hardback, with
over 250 artists contributing more
than 400 eclectic works.

Some of those pieces were created
for a 2017 exhibition at San Francisco’s
Spoke Art Gallery. As the exhibition
toured over the following two years it

Ponyo takes human
form in this detail from
an illustration by US
artist Stacey Aoyama.

| grew in size, as more creatives
. interpreted characters and key scenes.

Following an introduction from the

i curator of the exhibition and a potted
i history of Hayao Miyazaki, the reader
: is then free to explore 240 pages of |
- incredible work filled with unique takes
. on My Neighbor Totoro, Howl’s Moving -
Castle, Spirited Away and more. The i
. media is varied: from traditional

. materials such as inks and

| watercolours, to paper lanterns,

¢ embroidery, sculpture and digital

i prints. It's a credit to Hayao’s strong

i vision that his designs remain

. recognisable in even the most extreme
interpretations, such as Princess i
Mononoke’s headdress being turned
. intoagas mask by Freehand Profit

(aka Gary Lockwood).

$j00g SWeIqy/AlB|IED My B0dS @ sebewl |y

| Self-taught Los Angeles artist Nan Lawson painted
- her version of Princess Mononoke for the exhibition.

While it’s a pity that there’s no
creative insights on offer, this book

| remains a solid collection of art that
- Studio Ghibli fans will lap up.

| RATING %k 'ryy
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See page 6 now!

Workshops assets are available...
If you see the video workshop badge then you can watch the artlst
ND 1 FOR DIGITAL ART[STS in action. Turn to page 6 to see how you can get hold of the video.

T radltlonal Artist

Inspiration and advice from the best pro artists

This issue:

84 Traditional FXPosé
Discover this month’s selection
of the finest traditional art,
which has been sent in by you!

88 Workshop: 11 tips on
rendering perfect portaits
Jean-Sébastien Rossbach reveals
how he works with watercolour.

94 Workshop: Develop
your fish-eye art skills
Learn how Paul Heaston is able
to create a wide-angle sketch.

98 First Impressions:
Wylie Beckert

This Magic: The Gathering artist
is thankful for social media.




Traditional Artist FXPosé

FXPosé

SHOWCASING THE FINEST TRADITIONAL ARTISTS
S ke

Madalina Buzenchl

LOCATION: Italy MEDIA: , pencils, tz.com
Nature is Madalina’s main source of mspiration - she
finds it best enhances the human figure: “I capture
the most delicate feelings in dreamlike portraits.”

lp EI ot

.

E ' iy

NATURE JEWELS

“l used to collect stones when | was a child,
so | wanted to impress this beautiful memory
on the paper.”

MAGIC INTO THE WOODS

“Nature at night is a mysterious place
where magic can happen. | used the negative
painting technique to obtain a 3D effect.”

SENSATIONS

“A single leaf that touches us can evoke a
series of memories. | made this piece for my
watercolour illustration course.”

LIGHTS

“I was inspired by my favourite Disney
movie, Tangled, and especially by the lights
on the lake. In this case the protagonists are
me and my husband.”

$ limasiiieRX Want to submit your work? Visit ifxm.ag/getinifx




Want to submit your work? Visit ifxm.ag/getinifx




Traditional Artist FXPosé

% Johanna Puh

LOCATION: MEDIA: Oil, i and WEB: j; .com

“Beside video games, nature is a huge inspiration for my art,” says concept
artist Johanna. “I love the organic nature of watercolours, but also the
control you have over a digital drawing, so | try to combine both.”

EI L ROBOT AND ROSES
@ “My botanical bot series

S L n&\ depicts humanoid machines,

(== \ overgrown by different kinds
of flowers and plants. They
are digital drawings, done
with watercolour brushes
and paper textures for a

‘ natural look.”

MUSEUM DRAWING

“I love to get inspired by
62:) actual history and culture, so
| go out to museums or the
zoo with artist friends from
time to time. This page was
done in an Aztec exhibition
and coloured at home later.”

CREATURES FROM

IMAGINATION
“This is one of my favourite
sketchbook pages, featuring
organic plants and fantastic
creatures. | want to make
more time for my analogue
sketchbook again.”

THROUGH THE

FOREST
“A spontaneous little
watercolour painting of two
riders and their unusual
horses. | love creating little
fantastic worlds like this,
which make the viewer want
to join on an adventure.”

L

& 2

Want to submit your work? Visit ifxm.ag/getinifx




Inspirational art

GRUNLINGS

“These cute fruit and veggie creatures
are probably my most-known characters
and | have a huge collection of them now.”

Want to submit your work? Visit ifxm.ag/getinifx linasjiieFX w




Traditional Artist
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Watercolour

11 TIPS ON RENDERIN G
PERFECT PORTAITS

JEAN-SEBASTIEN ROSSBACH reveals his methods of working with watercolour
- the classic traditional medium that’s both simple and complicated

3 ImaginerX



pe . Perfect portraits

You have to stay open to how

watercolours interact with

pigments and the paper, and
readjust all the time

A

Salt effects

Water sta

atercolour is my
preferred painting
medium. It's easy

to work with, and
safe because it

I often make the analogy between

: watercolours and dance, because the
© colours somehow have their own life

and flow. When working on a new

. painting, you enter a game of

As I'll explain in this article, the
amount of water you use, the type of
paper and the granularity of your
pigments are all important factors
when helping to take your colours

requires neither solvents nor

mediums. But as with many things

in life, simple can also be hard, and

achieving the art goals you have in .

mind can be challenging if you're not ‘M[(/Md/
aware of a few techniques and tools,

which we'll review together here. t7 AV [6

- suggesting and reacting. And this is
. what I like about the medium. You

' have to stay open to how

- watercolours interact with pigments
- and the paper, and readjust all the

| time. Over time I've found it's

. become a philosophy of letting go.

where you want them to go.




Traditional Artist Workshop

1 What paper should I use?

The answer depends on your personality and the
result you want to achieve. There are papers with grain,
there are permissive papers, there are smooth papers,
papers with tooth, and so on. As an illustrator who likes
precision and details, | prefer cold press paper with no
grain. | rarely go under 300g/m2, and my big paintings
(which are over a meter tall) are 600g/m2.

My advice is to begin with the best paper and avoid
those designed for students: the quality is poor and you
never achieve good results with them. My preference is
Arches and Fabriano. Arches accepts no compromises.
Select it if you're a fiery artist who likes sharp results.
Fabriano is a smoother paper, but you can still be
precise. It's also more forgiving, which means you can
erase mistakes more easily than with the Arches papers.

- Sm————

Consider calligraphy brushes
I’'m the first to say that good tools make good
artists. Yet while you can buy $20 brushes made with
luxurious animal hair, | tend to find them unnecessary.
After using watercolour brushes for a decade, I've
started using Asian calligraphy brushes. They’'re

Work on an inclined plane
| paint on a slightly inclined plane. When attending

affordable, durable and have a big reserve, which watercolour events | discovered that many professional artists do
means you don’t have to reload them all the time. You this, especially those who paint portraits. The reason is that it leads
can make washes and then the pigments down the paper, which reinforces the illusion that the
switch to detailing in the sun in the sky is illuminating the portrait. Letting the pigments
same movement, without settle down when applying watercolour makes it easier to paint
having to change brushes. volumes and gradients. It results in your portraits looking more
I've found that they're also natural because the viewer is used to seeing a face with the source
ideal for creating dry of the light coming from above (in other words, sunlight).

effects and gradients.

However, | still use spalters “ Letting the pigl—nents Settle gently

when | want to cover large

surfaces quickly, because dOWIl When aPPIYing Watel'COlour InakeS

| like to paint on large

format sheets it easier to paint volumes and gradients 99




In depth Perfect portraits

Staining, granulation, transparency
Depending on the pigment used, each colour has
different properties. For example, Turquoise blue stains
easily, which means it’s hard to lift up with water if you
make a mistake. It’s also very transparent. Burnt sienna is
easier to wash away and it’s granulated and more
opaque. Granulation is something | look for when
painting backgrounds or non-organic elements because
it adds texture and a mineral aspect. For painting the

When to use coloured pencils
When making those finishing touches, | use coloured pencils.

skin | prefer a smoother colour that’s less prone to They are ideal for highlighting certain areas or creating precise
staining, such as Alizarin crimson. This information is edges. There are different kinds of pencils. Some are very hard and
usually provided directly on the watercolour tubes, oron  precise (Prismacolor), but not really good at coverage, while others
colour charts available from the brand’s website. are thick and loose (Derwent), but more pigmented.

Alternate dTy and wet . being the water itself. Don’t be afraid to make bold, confident marks
The magic of watercolour resides in one’s ability to make it . and see what happens. Then react to the actions of the water.

dance between wet and dry areas. Working wet on wet means you Working on a dry surface is for blocking shapes. | try to connect

paint on a wet surface. The colours can then mix and create abstract | dry and wet areas all the time because it brings a painting to life. It's

shapes that you can barely control. This is my favourite bit: the | not important that the blue of a fabric enters and mixes with the pink

moment when you'’re the co-creator of the painting, the other one i of a person’s belly. The colours aren’t as important as the values. 3>
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Traditional Artist Workshop

[l Create contrast in your watercolour art

THE BACKGROUND

To fire up my motivation | begin
this portrait of a geisha with the fun
part: the background. It’s a wash of
Payne’s grey, Raw umber and touches
of Burnt sienna loosely applied wet on
wet to encourage granulation and
staining effects. This is also the stage
when | block in my composition.

SUPPORTING COLOURS

I place the darkest colours all
around the character’s face because
I’'ve decided that I'll keep her face
completely white. Watercolour is very
often a matter of finding a way to
create contrast, because the medium

itself is rather pale and desaturated. By UTILISE THE WHITE OF THE PAPER FOR THE GEISHA’S FACE

putting all the darker tones around her Her face is the last thing | paint - or should | say | actually don’t paint, because | keep the white of the
white face Pll make it stand out from paper preserved to convey the white make-up on her skin. Even the bottom of the composition is covered with
the rest of the composition. a light grey wash so that the only pure white is that of the geisha’s make-up.

liviagiie X




The secret to painting volumes

Painting accurate volumes can trip up artists,
whatever their experience level. One’s attention is taken
up by the style and the splashes of overflowing colours,
but the volumes are neglected and the finished portrait
looks flat. This is mainly due to the desaturated nature of
this medium. If | want to convey the illusion of a realistic
portrait, | need to focus on tones, not colours. Good
tones leads to good volumes, which results in a good
portrait. Unlike oil paint, I'll go from very light washes to
strokes that are gradually more loaded with pigment in
order to build up the volumes. It’s exactly like adding
Multiply layers on top of each others in Photoshop!

Preserving white areas

The natural white colour of the paper is the purest
white I'll ever get. Before applying any paint on the
surface | identify all white areas | need to preserve. | try
not to apply any water there, and use masking fluid if
required. | try to avoid the use of white paint because it
always ends up looking greyish and dirty.

In depth Perfect portraits

. Expresswe

ground
When | pa|nt Ilvely portraits,
| don’t want to overdo the
background. Details are
unnecessary here and can even
be counterproductive. The
most important element in a
portrait are the eyes. This is

where | want to concentrate the |
. effects. | use salt to create

| texture, and let the water drip
¢ and make stains.

viewer’s attention. So this is
where all the details, the
smooth gradients and

transitions need to go. On the
other hand, what will make my
piece stand out is its painterly
feel - its expressiveness. I'll put
all this in the background, like
an abstract case that stores
the beautiful figure | spent so
much time and effort on. The
background is the playground
where | experiment with water

6 The most important element in a
portrait are the eyes. This is where I want
to concentrate the viewer’s attention 99

Using salt to create textures
| recommend trying this simple and fun watercolour technique: prepare a

wash with lots of water and a fair amount of pigment, then apply it and spread
kitchen salt over it. Let the paper dry. The results may be a pleasant surprise! @
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Traditional Artist Workshop

DEVELOP YOUR

See page 6 now!

FISH-EYE ART SKILLS

Learn how US illustrator PAUL HEASTON is able to create a wide-angle
“point of view” sketch from life using pencil, pen and ink wash

ook as far as you can to
your right and to your left
without turning your head.

Now do it again but looking |

up and down. Everything
you can see in front of you without
turning your head makes up your
“field of view.” What if you were try
to draw every single thing in that
space? How do you reconcile all of

that information within the confines |

of a rectangular picture plane?
Years ago, when I first started

doing sketches from life, I was trying

to draw a row of buildings from
across the street. I wanted to include

everything I could see; the whole city |
block. I sketched the top and bottom !

MATERIALS

DRAWING TOOLS

B Tombow Mono

4B pencil

M Staedtler 0.3
Pigment Liner

H Molotow One4All
white acrylic paint
marker

M Pentel grey brush pen
M Kuretake water brush
and diluted Noodler’s
Lexington Gray ink

M Pentel Hi-Polymer
Eraser

PAPER

M Stillman & Birn
Epsilon paper

i edges of the buildings parallel to the
. horizon but it just didn't look right.

Then I remembered how buildings

| in panoramic photos are wider at the
. centre and they taper down to the

| right and left as they recede from the
viewer. In doing this, the top and

| bottom edges of the buildings curve
. to meet vanishing points on the

i horizon to the right and left. I tried

| this in my sketch and it worked!

While it felt like a breakthrough

| for me, it turns out, many other

. artists had been exploring the

| concept of curving perspective for
- years, from Parmigianino in the

: 1500s to MC Escher in the 20th

i century to Kim Jung Gi today.

Odds are by now you have
encountered wide-angle art before.
Whether you've heard it called
fish-eye, bubble art, curvilinear
perspective or something else, the
idea is the same: to fit a lot of space
on the page you have to bend that
space a bit. There are a few ways to go
about doing that, and I'm going to
show you how I like to approach a
wide angle drawing or “point of
view” sketch in a few simple steps.
L]
R
ngle perspective. Follow him on Twitter

at twitter.com/paulheaston.




In depth Fish-eye art

210°
(||||" STERE0SCo ?lt\

4
. Adopt a wide-
’ angle mindset

This is the most challenging
yet crucial step in tackling a
wide-angle sketch from life. 1
We're used to zooming and

°
- cropping to select small 150

: 3 portions of our field of view

Select a suitable space. to render on the page. Think f

You can do a wide-angle sketch in practically any outdoor or indoor space, “wide” - your drawing will !
but for sheer volume of detail in all directions | love a cluttered interior space. | include what’s to your right ‘4‘
chose to sketch my friend’s woodworking shop because there was just so much and left and what’s above H
visual information in every corner of the room. and below you.

Draw a curved perspective grid

Start with a horizon line just over halfway up the page. Add a centre vanishing point (VP) on the horizon, one VP each on the left and
right edges of the paper, and one at the bottom directly beneath the centre VP. Draw increasingly curved arcs connecting the left and right
VPs above and below the horizon. Add straight lines radiating from the centre VP and lines gently arcing up and out from the bottom VP.

Foreground first

In pencil, loosely sketch your hands, sketchbook
or drawing surface, and anything else that might be in
your immediate foreground (legs, chair, work surface

— o2

Block in basic shapes
Using the grid as a reference for direction and your foreground as a

and so on). The scale you choose for this portion of the reference for scale, roughly pencil in the biggest portions of your field of view. | like
drawing is important because this will establish a scale to work roughly left to right and foreground to background in successive passes,
reference for the rest of the drawing. correcting as | see fit to keep everything in proportion. 3>




Traditional Artist Workshop

Inking isn't just tracing

An underdrawing is a rough draft. As you add ink
you'll encounter things you want to change as you go. st oz
Feel free to move elements, change scale and 7 Leading edges/surfuces _ﬁTSt
proportion, and fix perspective issues right then and When you have a big, messy visual element like a pile of lumber receding

there, and add any information that wasn't in the away from the viewer, it can be tricky to know where to start. Keep it simple;
underdrawing. You’re not beholden to earlier choices address all the nearest surfaces and edges first and then draw the lines receding
that you made in the pencil sketch. away toward the vanishing point once the foreground portion is done.

s
r
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Just keep drawing and erase as you go
Of course, ink is permanent and you will make
mistakes. | make tons of ‘em. Just draw right over them.
Of course you should fix the stuff that isn’t working, but
don’t worry about the mistakes still being visible. In a
wide-angle sketch the visual impact of the whole is
greater than the sum of its parts. This sounds obvious,
but even | need to remind myself to tidy up now and then
so | have a clearer picture of what’s happening in the
drawing. Often it’s only after you erase the underdrawing
that you can see where additional ink work needs to be
done, as well as any mistakes that need addressing.

Value makes it pop

The heavy lifting in a sketch is done when the
values are added. | use hatching and ink wash to push
contrast and transform the linear forms into something
that feels three-dimensional. Don’t be timid here: a good,
contrasty drawing is much more appealing than a
washed-out, halfway finished one.




In depth Fish-eye art

- &
Vertical hatching
To create a lot of my values | use a mix
of hatching and ink wash. Vertical hatching is
a good way to lay down a lot of value quickly
and it’s hard to screw up. | use the word
“vertical” loosely, as | like to keep my hatch
marks consistent with the perspective and
point toward the bottom vanishing point.

Ink wash in a brush

This is a trick | learned from artist Ed
Mostly out of Bath, England. | use Noodler’s
Lexington Gray fountain pen ink in a Kuretake
water brush diluted with water to add grey
values. It’s an ingenious way of making ink
wash portable and it’s so convenient and
mess-free, | use it in my home studio as well.

LTI
Vb8 P
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Dab large flat areas
To keep a large flat area from appearing either
unaddressed or overworked, attack the space with light
dabs, flecks and speckles of wash. You can layer these
marks to make areas darker gradually without the
frustrating streaks and tide marks that come with trying
to achieve a smooth gradient in wash.

Layer your washes

The nice thing about a waterproof ink
wash is, once dry, you can apply more wash
to get darker. This way you can build up to
the darkest values without worrying about
overdoing it on the first pass. Keep several
water brushes handy with different shades
of grey to speed up the process.

White pen for highlights

It’s a small thing but when done correctly, adding a few white highlights can
make a black and white sketch sing. Look for where the whitest whites should be
in your drawing (lights, reflective surfaces and so on). Just a couple of subtle white
highlights on the rim of this metal canister really make it pop and feel metallic. #
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This Magic: The
Gathering artist
thanks social media

How did your post-
college years affect
your art?

Ilived in a miserable,
unheated house in

job that paid $260 a week. The
upside of this was that the low cost

of living meant that transitioning to

the unprofitable life of a newly
minted illustrator wasn't too much
of an adjustment for me, and with

no distractions and (nearly) nothing -

to lose, I was able to devote myself
to studying art fundamentals and
building my illustration skills in a
way that someone with a cushy
studio job in an expensive city

would never have been able to. That

period of my life was both a
hardship and a luxury.

Is the online social side to modern
art a burden or an aid?

A burden, but an indispensable one.
Long before I was getting hired
professionally, social media allowed
me to build a sustainable career for

FAE OF WISHES

Card art created for Magic: The Gathering's Throne of Eldraine

expansion using ink and pencil on paper.

o

rural Maine and worked a part-time

- WICKED KINGDOM :
- THEKING OF CLUBS

* “Atraditionally painted playing

card deck with a narrative twist
and a dark fantasy aesthetic.”

71735200 93O SPIEZI ©

Traditional Artist Interview

myself rather than sitting on my
hands waiting for the emails from
art directors that never came.

I was first hired by Magic: The
Gathering - now my main client
- in late 2019. A full three-and-a-
half years after I Kickstarted my
first self-directed project, Wicked
Kingdom. If it hadn't been for social
media channelling support to my
crowdfunding campaigns on
Kickstarter and Patreon, I would
have had to quit art in favour of a
‘real’ job years ago. Even if your
work isn't perfectly polished,
perfectly professional, social media
lets you put your work out in the

@8 If it hadn't been
for social media

[...] Iwould have
had to quit art 99

world and start building a following
- even if you're beneath the notice
of art directors for now.

‘What art has most affected you?

| Seeing Jacek Yerka's work made a

i huge impression on me early on.
Before that, I had thought of fantasy
art as a genre that existed solely in
an alternate-universe medieval
England: knights in armour,
dragons, fairies, castles. Yerka’s
paintings are much more personal:
they feel real, habitable and familiar
despite their strangeness. Yerka is
still my favourite artist to this day.

Has the art industry changed?
When I was getting started as an
illustrator [2014] many of the big
fantasy art brands were very rigid in
the type of artwork they would hire
- it seemed to be the peak of the
shiny, photorealistic digital
painting; with my line-based,

| traditional-media style, I was more

| or less unhirable. In recent years I've
noticed this status quo starting to
shift. Magic: The Gathering in
particular is starting to move
towards a less homogenous look
that's allowing a lot more unique
voices into the industry. Given the
positive response from players and
collectors, hopefully more
companies will follow suit.

What's next for you?

I've been more or less tied up with
one project over the past three years
(my playing card deck Reign of Sin).
Doing a large-scale project like RoS
has meant being locked into one
very narrow style and painting
process; now that it's almost
finished, I'm looking forward to
starting something a lot less
structured! Creating an illustrated
fairy tale collection has been on my
list ever since I saw Shaun Tan’s
amazing book The Singing Bones

- it’s certainly on the horizon!

Wylie shares her artworks and process

at wyliebeckert.com.
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bigger & better brushes | deeper paints | cloner tools | layer effects and more
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deeper oil paints | enhanced custom brush designer | complimentary color system
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